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Notice
 It is strictly prohibited to write or copy a part or whole of this document without 

our approval.
 The contents of this document may be subject to change without notice.
 Due to improvement or change of this software, the description of this docu-

ment could be partially different in specification, for which your understanding 
is requested.

 It is strictly prohibited to copy this software to other disk (excluding the case for 
making backup) or to load on the memory for the purpose other than executing 
it.

 With the exception of what is provided for in the warranty provisions of MIMAKI 
ENGINEERING CO., LTD., we do not assume any liability against the dam-
ages (including but not limited to the loss of profit, indirect damage, special 
damage or other monetary damages) arisen out of the use or failure to use of 
this product. The same shall also apply to the case even if MIMAKI ENGI-
NEERING CO., LTD. had been notified of the possibility of arising damages in 
advance. As an example, we shall not be liable for any loss of the media 
(works) made using this product or indirect damages caused by the product 
made using this media.

 All brand names and product names in this document are trademarks or regis-
tered trademarks of their respective companies.

 Adobe, Adobe logo, Photoshop, Illustrator and Postscript are trademarks of 
Adobe Systems Incorporated. 

 Microsoft, Windows, Windows XP, Windows Vista, Windows 7, Windows 8, 
Windows 8.1 and Windows 10 are registered trademarks or trademarks of Mic-
rosoft Corporation in the United States and other countries.

 Apple, Macintosh, Power Macintosh, Mac OS and Mac OSX are registered 
trademarks or trademarks of Apple Inc.

 In addition, the company names and the product names in this document are 
trademarks or registered trademarks of each company. 
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About this guide
This document explains how to operate Mimaki Profile Master II.

Notations used in this document

Items appearing on the menu are expressed with " " for example "creation".
Buttons appearing on the dialogs are expressed with  for example .
Tabs appearing on the dialogs are expressed with [ ] for example [Gray balance].

Ink colors

In this document, the ink colors are expressed with abbreviations as follows:
C = Cyan, M= Magenta, Y= Yellow, K= Black,
Lc = Light cyan, Lm= Light magenta, Or=Orange, Gr=Green

Symbols

This symbol indicates points requiring attention in operating this product.

This symbol indicates what is convenient if you know it.

This symbol indicates reference pages of the related contents.
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Mimaki Profile Master II
Mimaki Profile Master II (hereafter MPM II) is an application software for creating the following pro-
files.
 Device Profile and Input Profile of Raster Link series that is RIP application made by 

MIMAKI ENGINEERING CO., LTD.
 Output Profile for the RIP application compatible with ICC Profile made by other companies

Special features of the product

By using a new format Device Profile supporting 16 bit color, the printing            
quality is improved

Using together with RIP application later than Raster Link Pro III series v.1.00 or later, the 
accuracy of the gradation image will be improved.

Calibration function reduces the change of printer colors

Even when the printer has undergone a color change due to temporal change or due to 
change in season or weather, the original color can be regained easily. 
This function can be used in the RIP application of Raster Link Pro III series v.1.00 or later.

Equalization function reduces the difference of the colors between        
printers

When the printed colors become different due to character proper to the equipment even if the 
same type of equipment is used with the same profile, the difference of colors of each printer 
are reduced and the same output result will be obtained from whichever printers used.
This function can be used in the RIP application of Raster Link Pro III series v.1.00 or later.

Profile can be created easily within short time

With a wizard type just to follow the instructions appearing on the screen, the profile can be 
made easily.

Color matching to the color sample has been realized

Combining the ColorPicker of X-Rite Corp. and the color replacement function of Raster Link 
series, it fits to the color sample for output.

Color simulation function reduces color adjusting work of image

You can reproduce color output with the printer manufactured by Mimaki on the monitor or with 
the printer for proof (consumer printer).



XI

What is profile ?
An output profile used in Raster Link series is called a "device profile". 
MPM II can create two kinds of profiles shown below. 

 A file with its extension "cot" used in Raster Link Pro to Raster Link Pro5.
 A file with its extension "icc" used in Raster Link Pro II v3 or later.

Various information required for the RIP processing are written in the extension "cot" Device Pro-
file, which is a unique format for the Raster Link series.
Information unique to MIMAKI ENGINEERING is added to the extension "icc" Device Profile which 
complies with ICC format. It can be used as an Output Profile for the RIP application compatible 
with ICC Profile made by other companies. 
Installing Device Profiles created by MPM II into the Raster Link series enables to print outputs to 
which the created profiles are applied. 

Device Profile

Raster Link series

Device Profile installation 
Chapter 7

Enable to print applying the Device Profile

Mimaki Profile Master II
Profile creation Chapter 2

Device Profile
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Enable to print applying the Device     
Profile
If you use MPM II trial version, there are restrictions as follows:
 Trial period will be 60 days.
 Media name cannot be registered.
 The function to create ICC profiles of CMYK color, RGB color and monitor cannot be used.

MPM II uses two dongles.
Unless you use black-colored dongle (MPM II dongle), MPM II is activated as 
trial version.
Unless you use violet-colored dongle (ProfileMaker dongle), MeasureTool5.0 
and ColorPicker5.0 are activated in demonstration mode.
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Starting MPM II

1 Double-click  , then MPM II starts.

When starting MPM II for the first 
time,the screen on the right is dis-
played.

2 Click  for settings.

Even when starting MPM II 
for the second time or more, 
if the media name registra-
tion or measurement device 
selection has not been com-
pleted, the screen on the 
right is displayed.

 When ">Registration of a media name" is displayed, 
go to P.1-3 , Step 2.

 When "> Selection of a Measurement device" is dis-
played, 
go to P.1-6 , Step 2.
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Settings before creating a profile
Before creating a profile, complete registration of a media name (  this page) and the selec-
tion of a measurement device ( P.1-6).

Registration of a media name

Register the new media name desired to be used newly on the database.

Registration of a media name

Register the media name desired to be used to the database.

1 Select the [Setting] tab and 
click "Media name".

The dialog for the media name registra-
tion will appear.

2 Check the media name, then 
select the media material, as fol-
lows.

Media Group : 
Select the media material group. This 
information is used only to broadly 
categorize [Media Type].

Media Type : 
Select the type of media material. 
This information is used only with V3 
profiles and is displayed in the Ras-
terLink series that is later than the 
RasterLink6. 

When using the MPM II trial version, a media name cannot be registered.

A maximum of 29 one-byte characters can be entered as the Media Name.
Characters that cannot be used 

' " \ * / ? : < > | 
You cannot register a Media Name that has already been registered.
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3 Click .

The registered media name will be 
added to the list.

4 Click .

The screen returns to the main menu.

 To cancel the registration of 
media name,
(1) Click .

(2)Click .

 The same media name that is included in an already registered list cannot be 
registered.As the following error messages appear, re-enter another name.
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Deletion of a media name

The registered media name is deleted.

1 Select the [Setting] tab and 
click "Media name".

The registered media name will be dis-
played in the media name registration 
dialog.

2 Select the media name that 
you wish to delete.

3 Click .

The confirmation dialog is displayed.

4 Click .

The selected media name is deleted 
from the list.

5 Click .

The screen returns to the main menu.

When a device profile has already been created with a media name registered 
on the database, do not delete the media name. When it is necessary to delete 
it, register a new media name and then rewrite to a new media name using the 
profile copy function ( Chapter 5).

 If you click  , the deletion is canceled.
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Selecting a measurement device

Select a measurement device to be used for measuring the color chart.

1 Select the [Setting] tab and 
click "Measurement".

2 Selecting a measurement 
device

3 Click .

The screen returns to the main menu.

Please confirm that the measurement device is connected to the computer and 
that the power is turned on.

 The driver must be installed if you are using the USB port to connect the mea-
surement device. Refer to the included operation manual for the measurement 
device, install the driver, and then connect the measurement device to the com-
puter.

 If a measurement device is used on Windows7, installation of the driver may 
fail when connecting the device to the computer. Please refer to Appendix 
"When a measurement device is used on Windows7" and update the driver.

 To use i1 Pro2, select i1 Pro. 
 To use i1iO2, select i1iO. 
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Setting the output port

The details of the output port can be set. (If this is not necessary, no setting change is required.)

When outputting to a file

To send the output file to the printer, a separate application is necessary (Our RIP can make the 
output). When the output file is sent to the printer, the images are printed. If the file is sent to the 
printer that is different one specified at the time of creating the profile, then "Command error" or 
"Parameter error" may occur and it could not be printed properly.

1 Select the [Setting] tab and 
click "Output port".

2 Select the [File] tab and click 
"Buffer".

Set the Buffer and the Timeout value 
when necessary.

3 Click .

The screen returns to the main menu.

Selection of output port can be set in the dialog for "Image Edit" that is dis-
played when a test print and a chart is printed. ( P.2-66)

 To set the "Buffer" to the 
default value, click 

.



1-8

When outputting directly to the printer

The charts or images are output to the printer connected to the computer by an IEEE1394, 
USB2.0 or LAN cablel.

1 Select the [Setting] tab and 
click "Output port".

2 Select the [IEEE1394], 
[USB2.0] or [Ethernet] tab and 
set the "Buffer" and "Timeout 
value".

Set the Buffer and the Timeout value 
when necessary.

3 Click .

The screen returns to the main menu.

 To set the "Buffer" and "Tim-
eout value" to the default 
value, click 

.
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Option settings

You can set the following in the Option settings.

Unit setting : Select the unit of the length in mm/inch.
Operation : If this is set, when the  is executed on the ICC profile creation 

page of the device profile, the estimated ink consumption is displayed after 
printing.

Label : Select the items to be printed when printing the images in the device profile cre-
ation/editing.

Device profile name
Print the device profile name. ("N/A" is printed during creating the device pro-
file.)
Image file name
Print the printed image file name.
Default output condition
Print the number of Pass/Overprint/Print Direction/High speed print setting/ 
Half tone setting.
Actual output condition
Print the items set individually when test printing.
Information of profile data
Print the Feed correction value/Ink limit value/Variable dots and Light ink 
value/Imported file name, if these are set.

1 Select the [Setting] tab and 
click "Option".

2 Select the tab.

Select the tab from which you wish to set [Unit 
setting], [Operation], and [Label].

3 Set the tab.

Unit setting : Select the unit to display.
Operation : If you check this on, the expected 

ink consumption is displayed at the 
end of the printing.

Label : Check the items to print.

4 Click .
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Main menu
When starting MPM II, the "Main menu screen" appears. The Main menu screen includes the 
"Device Profile screen", the "ICC Profile screen", the "Setting screen", and the "Install screen".

Device Profile screen

ICC Profile screen

The screen indicates the profile creation/ edit/
copy screen for Raster Link only.

The screen indicates the ICC profile creation 
screen.

The screen indicates the MPM II setting 
screen.

The screen indicates the installation function.

Creates a device profile. Chapter 2

Edits the created device profile. 
 Chapter 3

The created device profile is modified to a 
device profile for a different model or ink set. 

Chapter 5

Resumes the device profile creation using 
theinterrupt file created by the [Interrupt] but-
ton ( P.2-74). P.2-75

Creates a metallic color profile. 
 Chapter 3

Create an ICC profile of CMYK color. 
 P.6-3

Create an ICC profile of RGB color. 
 P.6-7

Creates an ICC profile of monitor.  
P.6-11
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Setting screen

Install screen

Registers the media of the device profile to be 
created.   P.1-3

Selects the measurement device to use when 
creating the device/ICC profile. 
 P.1-6

Configures the settings of the output port.  
 P.1-7

Sets various assistant functions such as dis-
play unit. P.1-9

Installs/uninstalls the created device/input 
profile to/from Raster Link series other than 
Raster Link Pro. P.7-5
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Chapter 2 
Creating a device profile

Procedures for creating a Device Profile are explained.

Device profile creation flow ..................................... 2-2

Device profile creation ............................................. 2-4
Format selection .............................................................2-4
Profile condition setting ...................................................2-5
Media character setting ..................................................2-7
Extended information setting ........................................2-13
Variable dots setting  
(only when variable dots is selected) ............................2-15
Ink limit for the whole color  
(when Profile (V3) is selected) ......................................2-18
Ink limit setting (when Profile (V2) is selected) .............2-22
Light ink setting (only when light ink is selected) ..........2-26
Automatic adjustment of Linearizaion ...........................2-27
Ink limit for tertiary color  
(when Profile (V3) is selected) ......................................2-45
Automatic adjustment of Gray balance .........................2-49
ICC profile creation .......................................................2-52
Basic setting of calibration  
(when selecting profile (V3)) .........................................2-57
Device profile saving .....................................................2-60

Function buttons .................................................... 2-61
Test Print button, Chart Print button .............................2-61
Import button .................................................................2-67
Curve Edit button ..........................................................2-69
Adjustment button .........................................................2-71
Interrupt button .............................................................2-74
Resume ........................................................................2-75
Read measurement file .................................................2-77
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Device profile creation flow

 Format selection  P.2-4 
Select a format for the device profile depending on the Raster Link you are using.

In case you use Raster Link Pro II Ver.3 or later：Select Profile (V3)
In case you would like to use a profile for Raster Link Pro to Raster Link Pro5：Select Profile (V2)

 Profile condition setting  P.2-5 
Set conditions for creating the device profile (such as Printer, Ink set, and Resolution).

Media character setting  P.2-7 
If necessary, set the media character (such as Feed correction value and Heater            
temperature).

 Extended information setting  P.2-13 
If necessary, set the extended information (UV illumination).

 Variable dots setting (only when variable dots is selected) P.2-15 
Select variable dots that match the printing ink set, and then check the printing.

Procedures to create a device profile vary depending on the format you have 
selected in Format selection.

 Ink limit for the whole color (when 
Profile (V3) is selected) P.2-18 

Print the chart, and then set the ink limit        
that can be mounted on the media.

 Ink limit setting (when Profile (V2) 
is selected) P.2-22 

Print the chart, and then set the ink limit        
that can be mounted on the media.

 Light ink setting (only when light ink is selected) P.2-26 
Select light ink that match the media, and then check the printing.

When Profile (V3) is selected When Profile (V2) is selected
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Automatic adjustment of Linearizaion P.2-27 
The gradation characteristics of each CMYK ink is automatically adjusted by printing the chart             
and measuring the colors. 
Print the chart applied linearization and check whether the gradation of each automatically            
adjusted CMYK color is smooth. 

 Ink limit for tertiary color (when 
Profile (V3) is selected)  P.2-45 

Adjust the ink limit of the tertiary color by        
printing the chart. 

Automatic adjustment of Gray 
balance P.2-49 

The gray-scale characteristics and the    
chromaticness expressed by CMY-mixed   
colors are automatically adjusted by    
printing the chart and measuring the colors.      
Print the chart applied gray balance and      
check whether the gradation of    
automatically adjusted gray is smooth. 

Automatic adjustment of Gray 
balance P.2-49 (only when 
sublimation transfer ink is selected)

The gray-scale characteristics and the    
chromaticness expressed by CMY-mixed   
colors are automatically adjusted by    
printing the chart and measuring the colors.      
Print the chart applied gray balance and      
check whether the gradation of    
automatically adjusted gray is smooth. 

 ICC profile creation P.2-52 
The ICC profile is created by printing the chart and measuring the colors.

Basic setting of calibration (when 
selecting profile (V3)) 

P.2-57 
By printing the chart and measuring the      
colors, record "base colors" to correct     
colors.

Device profile saving P.2-60 
Save the created device profile.
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Device profile creation

Format selection

Select a format for the device profile depending on the Raster Link you are using.

In case you create a profile that can be used with RasterLinkPro to RasterLinkPro5
 Select Profile (V2).

In case you use Raster Link Pro II Ver.3 or later
 Select Profile (V3). 

Using Profile (V3) achieves higher quality output results.

1 Select the [Device Profile] tab 
and click "Creation".

Creation wizard 1 is displayed.

2 Select a format depending on 
the Raster Link series you are 
using.

3 Click .

Register the media name in advance. ( P 1-3 ) 
When the media name is not registered, you cannot select "creation" to create 
a device profile.

Continued on P.2-5 "Profile condition setting"
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Profile condition setting

Select the conditions required for profile creation and the media you use.
The following are 9 creating conditions:

1 Select a printer and a inkset 
which you want to create a 
device profile and click 

.

2 Select a media name and click 
.

You may select from the registered 
media names already registered in 
media name registration procedures  
( P 1-3 ).

3 Set the profile creation condi-
tion, and click .

• Printer • Ink set • Resolution • Number of Pass • Overprint
• Print Direction • High speed print ON/OFF • Half tone • Media name

Selectable combinations of the 
printer, ink set are predeter-
mined.

Selectable combinations of the 
printer, ink set, resolution, 
pass, print direction and high 
speed print are predetermined.

 In the case of the back lit 
media, as the color is repro-
duced by the transmissive light, 
increase the number of times of 
overprinting to make printing of 
high den¬sity.

Continued from P.2-4"Format selection"
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4 Check the previously set cre-
ation conditions.

To change the conditions, click , 
and then change the creation condi-
tions.

5 Click .

Creation wizard 2 is displayed.

You cannot return to "Creation wizard 1" from "Creation wizard 2". To change 
the profile condition after moving to Creation wizard 2, click  and redo 
the process from Step 1.

Continued on P. 2-7 "Media character setting"
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Media character setting

If necessary, set the information about characters (Feed correction value, Heater temperature, Dot 
size, Feed setting, Top Blower and Feed Direction).

1 Set each item below if required.

The items to be displayed differ depending of the printer type etc. when you set the profile 
creating conditions. 

 Feed correction

Perform feed correction on the    
printer and set the value. 
To store the value in the Device      
Profile, turn on the check box     
labeled [Switch a Feed correction    
setting on/ off] and then enter the      
value.

 Heater temperature

Confirm the suitable heater   
temperature with the printer, and set     
the value. 
To store the value in the Device      
Profile, turn on the check box     
labeled [Switch a Heater setting on/     
off] and then enter the value.

 For the Raster Link series, settings on the printer panel have the priority during 
initialization. If settings are required for the profile, set them here.

On setting suitable heater temperature, see the operation manual for each 
model.

Continued from P. 2-6 "Profile condition setting"
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 Dot size
Only in the following cases, dot size can be set.

1.When SS2 ink is used on JV3-SP/SL( This page)
2.When ES3 ink is used on JV3-SP/SL( P 2-9 )
3.When JF-1631/1610, JFX, UJV-160, UJF-706, UJF-3042FX, UJF-3042HG, UJF-

6042 or Tx400 is used 
( P 2-10 )

When SS2 ink is used on JV3-SP/SL

Out of the following two settings, select 
the dot size used at the time of output-
ting. 

• Recommend
: This is the recommended 

value.Select this setting in the 
normal cases.

• LL dot
: The dots are bigger than the rec-

ommended case.  
Select this, when the image with 
recommended setting is rather 
thin as a whole, or when streaks 
are found.

 The details of the profile creating conditions are as follows:
•Printer : JV3-SP-4Color series, JV3-SP-8Color series
• Ink set : SS2 CMYK, SS2 CMYKLcLm
•Output setting : 360x360 ND, 360x360 VD, 360x540 ND, 360x540 VD, 360x540 

HQ ND, 360x540 HQ VD, 360x720 ND, 360x720 VD

When setting is made as LL dot, the printing time will become longer than the 
case of the recommended setting.

 LL dot setting is available when JV3-SP’s firmware is Ver6.2 or above. For con-
firmation of firmware version, refer to the Operation Manual of your Printer.

When SS2 ink is not set on the printer, the LL dot setting will be ignored.
 To identify the dot size used when profile is installed to Raster Link series, it is 

recommended to add description indicating the use of LL dot to the media 
name.
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When ES3 ink is used on JV3-SP/SL

Out of the following two settings, select 
the dot size used at the time of output-
ting. 

• Recommend
: This is the recommended value. 

Select this setting when you are 
using firmware of JV3SP and 
JV3SL Ver. 7.40 or later.

• Compatible to old MPM
: Select this setting when you are 

using firmware of JV3SP and 
JV3SL Ver. 7.30 or prior version.

 The details of the profile creating conditions are as follows:
•Printer : JV3-SP-4Color series, JV3-SP-8Color series
• Ink set : ES3 CMYK, ES3 CMYKLcLm
•Output setting : 720x720 VD, 720x1440VD, 1440x1440 VD

 If you select "Recommend" when your firmware of JV3-SP/SL is Ver.7.30 or 
prior one, the printer will display the parameter error. Although the drawing is 
possible, the concentration becomes low. 

 For confirmation of firmware version, refer to the Operation Manual of your 
Printer.
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When JF-1631/1610, JFX, UJV-160, UJF-706, UJF-3042FX, UJF-3042HG, 
UJF-6042 or Tx400 is used

When you set printing setting to "VD", 
you can set three types of dot size 
below: 

Small : The smallest dot size
Middle : The intermediate dot size
Large : The largest dot size

When you set printing setting to "ND", 
you can set normal dot size.

 The details of the profile creating conditions are as follows:
• Printer : JF-16XX-4Color series, JF-16XX-8Color series, UJV-160-4Color, 

JFX-4Color, JFX-8Color, UJF-706-6Color, UJF-706-8Color, UJF-
3042FX-6Color, UJF-3042HG-8Color, UJF-6042-8Color, Tx400-
4Color, Tx400-8Color

Set the dot sizes in the manner: Small ≦ Middle ≦ Large.
You are recommended to set the dot size in the order of Large - Middle - Small.
 If you have JF-16XX series,the setting of the dot size is possible when the firm-

ware is Ver.2.80 or above. The version of the firmware will be displayed when 
the printer power is put on.

 For dot size setting of UJF-3042FX, UJF-3042HG, UJF-6042 and Tx400, the 
combination of selectable sizes has been determined in advance. 
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 Feed setting

(1) After checking "Enable setting of 
media feeding speed" box ,

(2)enter the value of media feeding speed 
set in the printer.

When using heavy media, media easy 
to be pasted, or the media the roll of 
which is bending, the feeding accuracy 
could be affected. By setting the Feed 
speed in slightly slower time, such 
effect may be mitigated.

 Top Blow
Only in the following cases, Top Blow      
can be set.

• When JV300 or CJV300 is used.

(1) Turn on the check box for “Switch 
top blower settings on/off”.

(2) Specify the wind amount at the out-
put from "Top blower power".

 Feed Direction
You can set FeedDirection when    
using CMYKLcLmColorSet in UJF-   
3042FX/UJF-3042HG/UJF-6042.

(1) Select ON in the “Switch feed 
direction settings on/off ” check 
box.

(2) Select one of the following 2 printing directions for color printing.
• Forward : Printing from the front toward the back.
• Reverse : Printing from the back toward the front.

2 Click .

 “High” is the recommended value. Select this setting in the normal cases.
When using a sublimation transfer ink, bleeding may occur at the “High”. 

Please select the “Low” in this case.
 If ink odor due to the ceiling fan is a concern, please turn the fan to “OFF”. 

However, the drying property is reduced, and it may become a cause of bleed-
ing.

 If you select OFF in the “Switch feed direction settings on/off” check box, the 
feed direction settings from the profile created with MPMII Ver.4.30 or earlier 
will be applied.
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Continued on P. 2-13 "Extended information setting"
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Extended information setting

If necessary, set the recommended print condition (UV illumination).

1 Set the item below if required.

 UV illumination

Select UV lamp presettings from “UV 
illumination
In “UV illumination”, you can select pre-
settings that match the printer and out-
put resolution in the profile.
The Pass, Print Direction, High-speed 
Printing and Special color overprint set-
tings that correspond to the presettings 
currently selected will be displayed in 
the “Recommended print condition” 
field.

 This will not be displayed if you did not select a printer compatible with the rec-
ommended print condition when you set the profile creation conditions.

 To heighten the print quality, you must set an optimized UV lamp illu-            
mination for each of the following conditions 
Media, Ink, Output resolution, Pass、Print direction(Bi-direction/     
Uni-direction), High-speed printing(On/Off), Special color over     
print(1 layer (only color, only special color) / 2 layers (special          
color  color, color special color) / 3 layers) 
With Mimaki ProfileMasterII, presettings are offered for the above con-         
ditions, and by selecting the presettings you can have them set for the            
UV lamp. (Note that for certain combinations of printer and output set-           
tings are not available those presettings.) For details of the preset-          
tings, see the separate Important Notes Regarding Mimaki Profile        
MasterII.

Changing the print conditions
 If the Pass, Print Direction and High-speed printing settings that correspond to 

the presettings selected are different from the profile settings, a warning will be 
displayed. If this happens, follow the procedure below to change these values.

(1) Click .

Continued from P. 2-11 "Media character setting"
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(2)A “Change Print Condition” list 
will be displayed.

In the list, select the print 
conditions that you want to 

change to. Then click .

A dialog box for confirming the 
changes will be displayed. If the 
changes are acceptable, click 

.

(3)The Pass, Print Direction and 
High-speed printing settings will 
be changed.

The new settings will be displayed 
in red in the “Profile data 
information” field.

About making settings on the printer
 If you want to use settings other than the presettings, select “PanelSetting”. 

(Note however that “PanelSetting” will only be displayed if the printer and out-
put setting combination is one for which presettings are not available.) 
Now set “UV lamp” on the printer to “Manual”, and set the values for light inten-
sity and so forth.

 To use settings other than “PanelSetting”, set “UV lamp” on the printer to 
“Host”. 
See the Operation Manual for your printer regarding the method for setting “UV 
lamp” on the printer.

Continued on P. 2-15 "Variable dots setting 
(only when variable dots is selected)"
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Variable dots setting (only when variable dots is selected)

Print the following chart, and then select variable dots that matches the ink set.

The variable dots spray the dots of 3 sizes (Small, Middle and Large) and make the gradation 
smooth. The optimum parameters are provided to make the gradation smooth according to the ink 
set you use.

1 Select variable dots.

The optimum dots for the selected ink 
set are displayed.

The content of the selected dots is dis-
played in [Explanation].

2 Click .

Check the printed result by using the 
selected dot.

 This screen is not displayed when a resolution that includes variable dots has 
not been selected. 
Go to P.2-18 "Ink limit for the whole color (when Profile (V3) is selected)" or P.2-               
22 "Ink limit setting (when Profile (V2) is selected)".

Continued from P. 2-14 "Extended information setting"



2-16

3 Select an image file for the 
output check.

4 Click .

The "Image Edit" dialog will be displayed.

5 Set the output condition ( P 2-61 ) and click .

The printer connected to the computer starts printing.

Only a CMYK TIFF image can 
be output until ICC profile cre-
ation is completed. 

 The image file supplied by 
MIMAKI is stored in the Image 
folder of MPM II.  
(TestPrint_Gradation.tif) 
When you have the chart exclu-
sively for confirmation, select 
the image file you have.

Depending on the output image size, set the media having a width of 600 mm 
(23.6 inches) or wider to the printer when printing only images provided by our 
company. 
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6 Check the printed image.

Check whether the gradation of the 
image printed by using the selected 
parameter setting is smooth. 

7 Click .

When Profile (V2) is selected
Continued on P.2-22 "Ink limit setting (when 
Profile (V2) is selected)"

When Profile (V3) is selected
Continued on P.2-18 "Ink limit for the whole 
color (when Profile (V3) is selected)"
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Ink limit for the whole color (when Profile (V3) is selected)

Print the chart, and then set the ink limit that 
can be mounted on the media.

1 Select a chart image from 
“Target Chart” list and click 

.

2 Set the output condition ( P 2-61 ) and click .

The printer connected to the computer 
starts printing.

When you create CMYK/
CMYKLcLm/CMYKLcLmLk 
color set device profile, you can 
select “Select a other image…” 
item. It can select your one 
image. You can only use a 
TIFF(CMYK) image for this.

Continued from P. 2-17 "Variable dots setting (only when variable dots is selected)"
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3 Click .

4 From the output image, determine the ink limit of each color.

 As priority order, the following order to set the ink limit of each color is recommended:
1 Red (R) hue
2 Black (K) density
3 Blue (B) hue
4 Green (G) hue 

This order is recommended by MIMAKI. It is fine to change the order to set the ink limit of 
each color.

 How to determine the ink limit
Visual checking is used to determine the ink limit.

 The following status of ink could become the cause for not being able to measure the 
color of the chart in the next steps.
a. The media is not dried even after several minutes. (This state depends on the cre-

ation environment.)
b. The ink is not dried evenly. (When a small rectangle is output with highly concen-

trated ink, the ink moves toward the outside and the density cannot be made evenly.)
c. Thin white lines cannot be expressed. 
d. A horizontally chained striped pattern like a necklace appears. 
e. Waved media result. The media are swollen.
f. When output with UV-curable ink, the reflection of the light differs greatly if looked at 

different angles.
g. The gradation is lost in highly concentrated areas.

 For high density printing, thin lines may not be expressed, or bleeding of some degree 
may be resulted because such printing requires an ink value of more than usual.

 The Ink limit value may differ depending on the creation environment (place, season, 
weather, temperature, humidity, etc.) because printing is affected by the temperature and 
the humidity.

 Even when the Ink limit value is appropriate, the printed image may sometimes have a 
problem in its looking if variable dots printing is used.  The variable dots spray the dots of 
3 sizes (Small, Middle and Large) and make the gradation smooth. However, in the case 
of some media, the dot size is insufficient to fill the distance between the dots in the high-
lighted portion to the middle tone portion where the small dots are used and the surface 
cannot be fully filled with the dots. In this case, "streaky tone" or "roughness" is felt by 
human eyes and may not turn out to be a desired image. Possible measures are as fol-
lows: 
a. Adjusting the ink value after the Device Profile has been created.
b. Making the density of the linearization curve a little higher.

 Device Profiles can be created with evenly allocated ink value, however, a better Device 
Profile can be created by setting each ink value with the secondary color and the tertiary 
color (gray balance and the like) considered.
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Select Black (K) density
densityThe ink limit of K is selected from the place of single color 
patch and of no ink excess. Also, the dots must be full.

Here we make K90%.

Select Red (R) hue Select Blue (B) hue Select Green (G) hue

From the color mixed portion 
of M and Y, select the portion 
showing the most desired R.

Here we make M100% and 
Y70%.

From the color mixed portion 
of M and C, select the portion 
showing the most desired B.

From the portion where R is 
selected, select the color 
located close to the ink value 
of M.

Here we make M100% and 
C80%.

From the color mixed portion 
of C and Y, select the portion 
showing the most desired G.

From the portions where R 
and B are selected, select the 
color located close to the 
crossing of the ink value of C 
and Y.

Here we make C80% and 
Y70%.

Therefore, the input values for primary color are C80%, M100%, Y70%, K90%.

 For the media liable to bleed the color, or difficult to absorb the ink, set the ink 
value taking into consideration the visual look and real color development.

How to determine the ink limit for Or and Gr: 
For Or, use the same ink limit as for M. For Gr, use the same ink limit as for C.

Not good

goodHow to decide the ink limit?
Then, some examples of deciding method of the ink limit are shown:

Good
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5 Enter the Whole amount.

Enter the Ink limit of each color that is 
determined in Step 3. 
You can enter numbers when clicking 
the number portion of each color.

6 Click  and then check the printed result.

( P 2-15 Step 2 to 5)

7 Click .

 There are three methods of entering a number:
• Entering a number on the keyboard.
• Changing the value by using up and down keys.
• Clicking the up and down buttons with the mouse.

 The image file supplied by MIMAKI is stored. (Inklimit.tif) 
When you have the chart exclusively for confirmation, use the image file you 
have.

Continued on P.2-26  "Light ink setting (only 
when light ink is selected)"
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Ink limit setting (when Profile (V2) is selected)

Print the chart, and then set the ink limit that 
can be mounted on the media.

1 Select a chart image from 
“Target Chart” list and click 

.

2 Set the output condition ( P. 2-61 ) and click .

The printer connected to the computer 
starts printing.

When you create CMYK/
CMYKLcLm/CMYKLcLmLk 
color set device profile, you can 
select “Select a other image…” 
item. It can select your one 
image. You can only use a 
TIFF(CMYK) image for this.

Continued fromP. 2-17 "Variable dots setting (only when variable dots is selected)"
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3 Click .

4 Determine the total ink value 
for tricolor (CMY) from the 
printed chart.

Decide the total ink value by checking 
the states of bleeding and outlined 
characters on the chart. 
Search the chart for the total ink value 
that gives a clear view of outlined char-
acters.

 How to determine the ink limit
Visual checking is used to determine the ink limit.

 The following status of ink could become the cause for not being able to measure the 
color of the chart in the next steps.
a. The media is not dried even after several minutes. (This state depends on the cre-

ation environment.)
b. The ink is not dried evenly. (When a small rectangle is output with highly concen-

trated ink, the ink moves toward the outside and the density cannot be made evenly.)
c. Thin white lines cannot be expressed. 
d. A horizontally chained striped pattern like a necklace appears. 
e. Waved media result. The media are swollen.
f. When output with UV-curable ink, the reflection of the light differs greatly if looked at 

different angles.
g. The gradation is lost in highly concentrated areas.

 For high density printing, thin lines may not be expressed, or bleeding of some degree 
may be resulted because such printing requires an ink value of more than usual.

 The Ink limit value may differ depending on the creation environment (place, season, 
weather, temperature, humidity, etc.) because printing is affected by the temperature and 
the humidity.

 Even when the Ink limit value is appropriate, the printed image may sometimes have a 
problem in its looking if variable dots printing is used. The variable dots spray the dots of 3 
sizes (Small, Middle and Large) and make the gradation smooth. However, in the case of 
some media, the dot size is insufficient to fill the distance between the dots in the high-
lighted portion to the middle tone portion where the small dots are used and the surface 
cannot be fully filled with the dots. In this case, "streaky tone" or "roughness" is felt by 
human eyes and may not turn out to be a desired image. Possible measures are as fol-
lows: 
a. Adjusting the ink value after the Device Profile has been created.
b. Making the density of the linearization curve a little higher.

 Device Profiles can be created with evenly allocated ink value, however, a better Device 
Profile can be created by setting each ink value with the secondary color and the tertiary 
color (gray balance and the like) considered.
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5 From the output image, determine the ink limit of each color.

 As priority order, the following order to set the ink limit of each color is recommended:
1 Red (R) hue
2 Black (K) density
3 Blue (B) hue
4 Green (G) hue 

This order is recommended by MIMAKI. It is fine to change the order to set the ink limit of 
each color.

Select Black (K) density
densityThe ink limit of K is selected from the place of single color 
patch and of no ink excess. Also, the dots must be full.

Here we make K90%.

Example : When 240% is selected as the total ink value in Step 4.

Select Red (R) hue Select Blue (B) hue Select Green (G) hue

From the color mixed portion 
of M and Y, select the portion 
showing the most desired R.

Here we make M100% and
Y70%.

From the color mixed portion 
of M and C, select the portion 
showing the most desired B.

From the portion where R is 
selected, select the color 
located close to the ink value 
of M.

Here we make M100% and 
C80%.

From the color mixed portion 
of C and Y, select the portion 
showing the most desired G.

From the portions where R 
and B are selected, select the 
color located close to the 
crossing of the ink value of C 
and Y.

Here we make C80% and 
Y70%.

Therefore, C80%, M100%, Y70%, K90% are selected and the CMY total ink value comes to 
250%, which exceeds the selected total ink value only by 10%.
In such a case, select the desired color again, and adjust the total ink value by reducing the 
ink value of each color.

 For the media liable to bleed the color, or difficult to absorb the ink, set the ink 
value taking into consideration the visual look and real color development.

Good Not good
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6 Enter the Ink limit.

You can enter numbers when clicking 
the number portion of each color.

7 Click  and then check the printed result.

( P. 2-15 Steps 2 to 5)

8 Click .

 There are three methods of 
entering a number:
•Entering a number on the 

keyboard.
•Changing the value by using 

up and down keys.
•Clicking the up and down 

buttons with the mouse.

When you wish to divide the total ink value determined in Step 4 to each CMYK 
color evenly, click .The total ink limit divided by 3. 
The calcuated value is applied to the ink value of each CMYK color.

 The image file supplied by MIMAKI is stored in the Image folder of MPM II. 
(Inklimit.tif) 
When you have the chart exclusively for confirmation, select the image file you 
have.

Divide this value to each ink

Continued on P.2-26 "Light ink setting (only 
when light ink is selected)"
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Light ink setting (only when light ink is selected)

Print the chart on the right and select a usage of 
light ink that matches the media. 
In the highlighted to medium tone portions of the 
gradation, by replacing the light ink with the darker 
ink, you will get smoother gradation without granu-
lar feeling. 
Several kinds of parameters are available to make 
the gradation expressed smoothly.

1 Select a usage of light ink.

The usage of light ink is explained 
below.

2 Click  and then 
check the printed result.

(  P.2-17  Steps 2 to 5)

3 Click .

 This screen is not displayed when an ink set that includes light ink has not been 
selected. 
Go to P.2-27 "Automatic adjustment of Linearizaion".

 The image file supplied by MIMAKI is stored in the Image folder of MPM II. 
(TestPrint_Gradation.tif) 
When you have the chart exclusively for confirmation, select the image file you 
have.

When Profile (V2) is selected
Continued from P. 2-25 "Ink limit setting (when Profile (V2) is selected)"

When Profile (V3) is selected
Continued from P. 2-21 "Ink limit for the whole color (when Profile (V3) is selected)"

Continued on P.2-27 "Automatic adjustment of 
Linearizaion"
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Automatic adjustment of Linearizaion

The gradation characteristics of each CMYK ink is automatically adjusted by printing the chart and 
measuring the colors. 
(Light ink is not adjusted.)
Check whether the gradation of automatically adjusted single color of each CMYK color is smooth.

The chart for measuring the colors has two areas.
The chart to be printed differs depending on the measurement device.

1 Click .

The "Target chart" screen displays dif-
ferent screens depending on the 
selected measurement device.

When the measurement device is not 
selected, the "Target chart" screen is 
not displayed.

Measure the colors after the ink has dried. Otherwise, correct measurement 
may not be executed.

When Profile (V2) is selected and the ink has not dried after leaving it for a long 
time, reduce the ink limit, and then print the measurement chart again.

a. Measuring part
Measure the colors by using a 
measurement device.

b. Visual checking part
Visually check this part.
(If you have selected the CMYKOrGr 
ink set, this part will be absent.)

When SpectroScan is selected in [Measurement]

Continued from P. 2-26 "Light ink setting (only when light ink is selected)"
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2 Set the output condition ( P. 2-61 ) and click .

3 Click .

4 Click .

When the measurement 
device has not been 
selected, the measurement 
device setting screen is dis-
played first.  
( P. 1-6 )
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5 The MeasureTool 5.0 is acti-
vated.

6 Measure the colors.

The measurement method varies depending on the measurement device you are using.
 When using Spectro Scan P 2-31 
 When using Eye-One Pro P 2-34 
 When using Eye-One iO P 2-37 
 When using DTP-41 P 2-40 
 When using i1 iSis P 2-42 

7 Click  and then 
check the measurement 
results.

( P 2-27  Steps 1 to 2)

Print the automatic adjustment results, 
and then check them.

8 At the visual checking part of 
the chart, check whether the gradation of each color is smooth.

When ProfileMaker dongle is not used, MeasureTool5.0 is activated in 
demonstration mode. When activated in demonstration mode, DTP-41 
cannot be used. (Other color measuring device can measure the color 
without problem.)

 If the adjustment looks insufficient, measure the colors on the chart printed in 
Step 7.  
Re-execute the automatic adjustment by the measurement as the fine adjust-
ment.

Executing fine adjustment by the automatic adjustment several times 
may not produce desirable result because fine adjustment around the 
target value is cyclically executed.

 For media that cause bleeding easily, delicate adjustment of the gra-
dation is difficult. Therefore, the gradation of the highlighted part 
becomes poor.

Also, you can adjust the each color data manually by clicking . 
( P 2-69 )
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9 Click .

When editing the curves, click  and check the printed results. 
The image file supplied by MIMAKI is stored. (TestPrint_Gradation.tif)

When you have the chart exclusively for confirmation, select the image file you 
have.

When Profile (V2) is selected
Continued on P.2-49 "Automatic adjustment of 
Gray balance"

When Profile (V3) is selected
Continued on P.2-45 "Ink limit for tertiary color 
(when Profile (V3) is selected)"
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When measuring colors using Spectro Scan

1 Set the printed chart in the 
measurement device.

2 Click "Device/
Port" of the tool 
bar.

3 "Instrument Configuration" is 
activated. Check the following items:

• In the "Instrument", the color 
measurement device set in P.1-6  is 
displayed.

• "Reflection" is selected.
• "Spectral" is not checked.
• [OK] is displayed below the "Port".

4 Close "Instrument Configuration".

5 Click "Chart" of 
the tool bar.

6 Click down-arrow of "Test Chart".

From the displayed lists, select the chart 
having the name of element for color 
measurement.
(In case of adjusting the linearization, 
select [Scan_Linearization.txt].)

When the measurement has to be made on the media the edge of which tends 
to wind up, fix the end of the media with tape, etc. so that the end of the media 
does not go up.

 If you desired to use Spectro Scan on the PC without serial port, please consult 
the sales agents of your color measurement device.

Please do not change the setting of "Language" with MeasureTool 5.0.

Do not change the color measurement 
device already set.

 The displayed list also includes color 
measurement devices other than Spec-
tro Scan. Make sure to select the list 
starting with [Scan_].
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7 Click .

8 Click .

9 Pressing the button on the 
measurement device, align the 
target chart with the part indicated 
on the screen (the upper left).

10 Press the Enter button of the 
measurement device, then the 
following screen is displayed.

11 Same as Step 9, adjust the lower left 
and lower right.

The measurement is automatically 
started.

12 From the menu bar, select [File]  
[Save As...] to save the color 
measurement results.

When saving the color measurement 
results, make sure to designate the "Files 
of type" as [Text Files (*.txt *.text)] for 
saving.
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13 Shut down MeasureTool 5.0.

Make sure that the file name stored at 
Step 12 is displayed in "Measurement 
File".

14 Click .

The curve is adjusted automatically. 
When completing the curve adjustment, 
the following dialog appears. 

15 Click .

The measurement is finished. Perform 
the procedures starting from Step 7 of 

P.2-29 .

 If you make color measurement more than 
once with MeasureTool, the last saved file 
name is displayed. If this is different from the 
color measurement result file you wish to 
use, click [Select measurement file.] to 
select the file of your choice.
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When measuring colors using Eye-One Pro

1 Click "Device/
Port" of the tool 
bar.

2 "Instrument 
Configuration" is activated. Check 
the following items:

• In the "Instrument", the color 
measurement device set in P.1-6  is 
displayed.

• "Reflection" is selected.
• "Spectral" is not checked.
• [OK] is displayed below the "Port".

3 Close "Instrument Configuration".

4 Click "Chart" of 
the tool bar.

5 Click down-arrow of "Test Chart".

Eye-One Pro chart is displayed. 
Select the chart having the name of 
element for color measurement. 
(In case of adjusting the linearization, 
select [i1_Linearization.txt].)

6 Click .

Place the chart on a flat place where the measurement can be performed eas-
ily. 

Please do not change the setting of "Language" with MeasureTool 5.0.
 To use i1 Pro2, select Eye-One Pro. 

Do not change the color measurement 
device already set.
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7 After the following dialog is 
displayed, put the main body of the 
measurement device on the white 
colored standard tile and then click 

.

Make calibration to display the 
measurement screen.

8 Set the "Mode" to [Strip with gaps].

9 In the first line of the chart (No.1) , 
put the measurement ruler, which is 
provided with the measurement 
device.

10 Align the measurement device with 
the measurement ruler and measure 
the colors.

Measure from the non-printed part on the 
left end to the non-printed part on the 
right. (Time shown is estimated in 
seconds.)

When the color measurement is 
completed properly, the color of the line 
to which the color measurement is 
completed changes and the display will 
instruct the color measurement of the 
next line.

If the color could not be measured 
normally, the message indicating that 
the measuring color has been failed is 
displayed. Measure the color again.

When you use the back board 
attached to Eye-One Pro, it is rec-
ommended to prepare the chart as 
described below. You can measure 
colors more easily because the 
measuring guide for the basic chart 
matches the half circle at the left 
end of the chart. 
(1) Cut the chart along the closing 

line.
(2)Push the chart against the left 

rear of the back board and clip it 
on.

Pressing the measurement button, 
measure the colors by sliding the 
Measurement device slowly at a 
constant speed from left to right. 

 For details, see the User's Guide 
attached to the measurement 
device.
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11 Similarly, measure the colors 
sequentially for the remaining lines.

12 When the measurement is 
completed, click .

13 From the menu bar, select [File]  
[Save As...] to save the color 
measurement results.

When saving the color measurement 
results, make sure to designate the "Files 
of type" as [Text Files (*.txt *.text)] for 
saving.

14 Shut down MeasureTool 5.0.

Make sure that the file name stored at 
Step 13 is displayed in "Measurement 
File".

15 Click .

The curve is adjusted automatically. 
When completing the curve adjustment, 
the following dialog appears. 

16 Click .

The measurement is finished. Perform 
the procedures starting from Step 7 of 

P.2-29 .

 If you make color measurement more than 
once with MeasureTool, the last saved file 
name is displayed. If this is different from the 
color measurement result file you wish to 
use, click [Select measurement file.] to 
select the file of your choice.
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When measuring colors using Eye-One iO

1 Set the printed chart in the 
measurement device.

2 Click "Device/
Port" of the tool 
bar.

3 "Instrument Configuration" is 
activated. Check the following items:

• In the "Instrument", the color 
measurement device set in P.1-6  is 
displayed.

• "Reflection" is selected.
• "Spectral" is not checked.
• [OK] is displayed below the "Port".

4 Close "Instrument Configuration".

5 Click "Chart" of 
the tool bar.

6 Click down-arrow of "Test Chart".

Eye-One iO chart is displayed. 
Select the chart having the name of 
element for color measurement. 
(In case of adjusting the linearization, 
select [i1iO_Linearization.txt].)

7 Click .

When the measurement has to be made on the media the edge of which tends 
to wind up, fix the end of the media with tape, etc. so that the end of the media 
does not go up.

Before measuring colors, confirm the driver with reference to the App.-13 
"Before using Eye-One iO".

Please do not change the setting of "Language" with MeasureTool 5.0.
 To use i1iO2, select Eye-One iO. 

Do not change the color measurement 
device already set.
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8 Set the "Mode" to [Strip].

9 Move the arm of Eye-One iO and set 
the graticule on the marked patch 
(the upper left).

10 Press the button on the side of the 
Eye-One iO.

The following screen appears.

11 The same as step 9, set the graticule 
in the lower left and lower right.

The following dialog appears after setting 
the bottom right patch.

When it is ready, click .

The measurement is automatically 
started.

12 When the measurement is 
completed, click .

13 From the menu bar, select [File]  
[Save As...] to save the color 
measurement results.

When saving the color measurement 
results, make sure to designate the "Files 
of type" as [Text Files (*.txt *.text)] for 
saving.
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14 Shut down MeasureTool 5.0.

Make sure that the file name stored at 
Step 13 is displayed in "Measurement 
File".

15 Click .

The curve is adjusted automatically. 
When completing the curve adjustment, 
the following dialog appears. 

16 Click .

The measurement is finished. Perform 
the procedures starting from Step 7 of 

P.2-29 .

 If you make color measurement more than 
once with MeasureTool, the last saved file 
name is displayed. If this is different from the 
color measurement result file you wish to 
use, click [Select measurement file.] to 
select the file of your choice.

 Measuring method for transparent media
When measuring the colors on media through which the background can be 
seen, the background colors affect the measured values. When measuring the 
colors with Spectro Scan, Eye-One Pro, or Eye-One iO, please do the following:

a. Media through which the background can be seen
Measure the colors by placing one or more sheets of white media of the same      
type or reliable white media under the target chart. Placing a sheet of black      
paper darken the color reproduction. When the background of the      
measurement device is white, such white media is not required.

b. Cloth media
The measurement method varies depending on the roughness of the cloth      
surface. 
When the surface is smooth (not fully transparent), measure the colors by      
placing a sheet of white paper in the same manner as the (transparent media)      
described above. 
When the surface is rough (fully transparent), print two sheets of the same      
chart, and then measure the colors by placing them over the white media.  
In particular, when measuring with a cloth media whose surface is glossy, use      
the polarizing filter provided with the measurement device. When using a      
measurement device that does not have a polarizing filter, a proper      
measurement may not result.

c. Transparent media whose backgrownd is printed in whiteink
Measure the colors from the observer. 
Since the white ink cannot fully hide the background, measure the colors by      
placing reliable white media or used as proofing print.
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When measuring colors using DTP-41

1 Cut the output chart along the dotted 
line.

2 Click "Device/
Port" of the tool 
bar.

3 "Instrument Configuration" is 
activated. Check the following items:

In the "Instrument", the color 
measurement device set in P.1-6  is 
displayed.

"Reflection" is selected.
"Spectral" is not checked.
[OK] is displayed below the "Port".

4 Close "Instrument Configuration".

5 Click "Chart" of 
the tool bar.

6 Click down-arrow of "Test Chart".

DTP-41 chart is displayed.
Select the chart having the name of 
element for color measurement. 
(In case of adjusting the linearization, 
select [DTP41_Linearization.txt].)

When connecting the old DTP-41, which has only serial cable, to PC without 
serial port, please consult your sales agents of the color measurement device.

Please do not change the setting of "Language" with MeasureTool 5.0.
When MeasureTool 5.0 is in demonstration mode, color measuring cannot be 

performed.
Before measuring colors on the chart, confirm the surface and the inner surface 

of ink on it have dried and cured. If ink has not completely dried, the roller in the 
measurement device may be stained with ink.

When using gummed media, please do not use it while stripped from the 
mount.

Do not change the color measurement 
device already set.

When [OK] is not displayed below the 
"Port", select the port on which the con-
nection is made and let it display [OK].
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7 Click .

8 Measure the 
measuring chart.

Measure the colors 
sequentially starting 
from the line at the left 
end. 

When the chart is not 
taken in when it is 
inserted, press the 
button of the 
measurement device. 

The line being measured is displayed on 
the screen. 
The alphabet on the screen indicates the 
line to be measured. 

When the measurement is performed 
properly, instructions for measuring the 
next line appears on the screen. 

9 From the menu bar, select [File]  
[Save As...] to save the color 
measurement results.

When saving the color measurement 
results, make sure to designate the "Files 
of type" as [Text Files (*.txt *.text)] for 
saving.

10 Shut down MeasureTool 5.0.

Make sure that the file name stored at Step 9 
is displayed in "Measurement File".

11 Click .

The curve is adjusted automatically. 
When completing the curve adjustment, 
the following dialog appears. 

12 Click .

The measurement is finished. Perform the 
procedures starting from Step 7 of P.2-29 .

When the color measurement was 
not performed properly, the lamp of 
the color measurement device 
flashes quickly and displays a mes-
sage prompting to repeat the color 
measurement again. In this case, 
please perform the color measure-
ment again.

 If you make color measurement more than 
once with MeasureTool, the last saved file 
name is displayed. If this is different from the 
color measurement result file you wish to 
use, click [Select measurement file.] to 
select the file of your choice.
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When measuring colors using i1 iSis

1 Cut the output chart along the dotted 
line.

2 Click "Chart" of 
the tool bar.

3 Click down-arrow of "Test Chart".

i1 iSis chart is displayed.
Select the chart having the name of 
element for color measurement. 
(In case of adjusting the linearization, 
select [i1iSis_Linearization.txt].)

4 Click .

5 Measure the measuring chart.

The following screen appears. Then, 
insert the measuring chart aligning the 
left edge of the chart with the left edge of 
i1 iSis.

When the chart comes to the end of i1 
iSis, the measurement is automatically 
started. 

Before measuring colors on the chart, confirm the surface and the inner surface 
of ink on it have dried and cured. If ink has not completely dried, the roller in the 
measurement device may be stained with ink.

Please do not use tightly curled media. It may cause media jam. 
When using gummed media, please do not use it while stripped from the 

mount.
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6 Click .

7 From the menu bar, select [File]  
[Save As...] to save the color 
measurement results.

When saving the color measurement 
results, make sure to designate the "Files 
of type" as [Text Files (*.txt *.text)] for 
saving.

8 Shut down MeasureTool 5.0.

Make sure that the file name stored at 
Step 7 is displayed in "Measurement 
File".

9 Click .

The curve is adjusted automatically. 
When completing the curve adjustment, 
the following dialog appears. 

10 Click .

The measurement is finished. Perform 
the procedures starting from Step 7 of 

P.2-29 .

 If you make color measurement more 
than once with MeasureTool, the last 
saved file name is displayed. If this is 
different from the color measurement 
result file you wish to use, click [Select 
measurement file.] to select the file of 
your choice.
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 When "Device/Port" of the tool bar is clicked after starting Mea-
sureTool 5.0 to measure colors using i1 iSis.

When "Device/Port" of the tool bar on i1 iSis is firstly clicked and then the color is 
measured, follow the steps below. 

1. Click "Device/Port" of the tool bar.

2. Check the following items:
• In the "Instrument", the color measurement 

device set in P.1-6  is displayed.
• "Reflection" is selected.
• "UVCut" is selected.
• [OK] is displayed below the "Port".

3. Close "Instrument Configuration".

4. Follow the step 2 to 6 of “When measuring colors using i1 iSis”.

5. Click  to save the color     
measurement results.
When saving the color measurement 
results, make sure to designate the "Files of 
type" as [Text Files (*.txt *.text)] for saving.

6. Shut down MeasureTool 5.0.
When MeasureTool 5.0 is shut down, the 
following dialog appears.

7. Click .

8. Click .

9. Select the file saved at step 5.

10.Click .

11.Click .
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Ink limit for tertiary color (when Profile (V3) is selected)

Print the chart, and then set the ink limit that 
can be mounted on the media.

 At this adjustment, ink limit is set for the 
composite colors using more than 3 inks 
except for light ink.

1 Click  to print the chart for measurement.

( P.2-18 Steps 1 to 2)

2 Click .

Continued from P.2-30 "Automatic adjustment of Linearizaion"
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3 Determine the total ink value for tricolor (CMY) from the printed 
chart.

Decide the total ink value by checking 
the states of bleeding and outlined char-
acters on the chart. 
Search the chart for the total ink value 
that gives a clear view of outlined char-
acters. 100% output for 

each color of CMY.

 How to determine the ink limit
Visual checking is used to determine the ink limit.

 The following status of ink could become the cause for not being able to measure the 
color of the chart in the next steps.

a. The media is not dried even after several minutes. (This state depends on the 
creation environment.)

b. The ink is not dried evenly.  
(If you print a concentrated small rectangle, the density does not become even 
because ink is not taken on evenly.)

c. Thin white lines cannot be expressed. 
d. A horizontally chained striped pattern like a necklace appears. 
e. Waved media result. The media are swollen.
f. When output with UV-curable ink, the reflection of the light differs greatly if 

looked at different angles.
g. The gradation is lost in highly concentrated areas.

 For high density printing, thin lines may not be expressed, or bleeding of some degree 
may be resulted because such printing requires an ink value of more than usual.

 The Ink limit value may differ depending on the creation environment (place, season, 
weather, temperature, humidity, etc.) because printing is affected by the temperature and 
the humidity.

 Even when the Ink limit value is appropriate, the printed image may sometimes have a 
problem in its looking if variable dots printing is used.  
The variable dots spray the dots of 3 sizes (Small, Middle and Large) and make the gra-
dation smooth. However, in the case of some media, the dot size is insufficient to fill the 
distance between the dots in the highlighted portion to the middle tone portion where the 
small dots are used and the surface cannot be fully filled with the dots. In this case, 
"streaky tone" or "roughness" is felt by human eyes and may not turn out to be a desired 
image.  
Possible measures are as follows: 
a. Adjusting the ink value after the Device Profile has been created.
b. Making the density of the linearization curve a little higher.

 Device Profiles can be created with evenly allocated ink value, however, a better Device 
Profile can be created by setting each ink value with the secondary color and the tertiary 
color (gray balance and the like) considered.
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4 Determine the ink limit of ter-
tiary color.

There are 2 methods of entering a 
number:
 Entering a number after clicking 

each box of colors.
 Clicking 

 
after entering a number into the 
box above the button.

5 Click  and then check the printed result.

( P.2-15 Steps 2 to 5)

Entering a number, which is 
bigger than the number of 
the Whole amount, into the 
Amount of tertiary color is not 
allowed.

 The image file supplied by MIMAKI is stored. (Inklimit.tif) 
When you have the chart exclusively for confirmation, use the image file you 
have.

 When dividing a number among the Amount of tertiary color.
Ink values applied after clicking  depends on the 
value set at P.2-18 "Ink limit for the whole color (when Profile (V3) is selected)".

(1)Divide the total ink amount by 3.

(2)The divided value is calculated with each ink value of the Whole amount.

Calculation formula

Calculation formula
(Divided value at the Procedure 1) * (Each ink value set at Step 4 of P.2-19 ) / 100

Example:
240% is set at the Step 3.
And each ink value of the Whole amount is set as follows.
K:90%, M:100%, C:80% and Y:70%

 240 / 3 = 80
 Ink limit of K: 80 * 90 / 100=72% 

Ink limit of M: 80 * 100 / 100=80% 
Ink limit of C: 80 * 80 / 100=64% 
Ink limit of Y: 80 * 70 / 100=56%
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6 Click .

When Profile (V2) is selected
Continued on P.2-49 "Automatic adjustment of Gray balance"

When Profile (V3) is selected
Continued on P.2-52 "ICC profile creation"
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Automatic adjustment of Gray balance

The gray-scale characteristics and the chromaticness expressed by CMY-mixed colors are auto-
matically adjusted by printing the chart and measuring the colors. 
Check whether the gradation of automatically adjusted gray is smooth.
Light ink and variable dots are not adjusted because they take the gray as a CMYK-mixed color.

The chart for measuring the colors has two areas. 
The chart to be printed differs depending on the measurement device.

1 Click  to print the chart for measurement.

(  P.2-27  Steps 1 to 2)

2 Click  and 
measure the printed chart.

Measure the colors after the ink has dried. Otherwise, correct measurement 
may not be executed.

 If you have selected CMYKOrGr ink set, this will not be displayed. 

a. Measuring part
Measure the colors by using a 
measurement device.

b. Visual checking part
Visually check this part.

When SpectroScan is selected in [Measurement]

When Profile (V2) is selected
Continued from P.2-30 "Automatic adjustment of Linearizaion"
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3 Click 
.

4 The MeasureTool 5.0 is acti-
vated.

5 Measure the colors.

( P.2-29  Step 6)
Select "XX_GrayBalance.txt" for the chart name. (XX is the name of the color measuring 
device.)

6 Click  to print 
the automatic adjustment 
results.

( P.2-27  Steps 1 to2)

When ProfileMaker dongle is not used, MeasureTool5.0 is activated in 
demonstration mode. When activated in demonstration mode, DTP-41 
cannot be used. (Other color measuring device can measure the color 
without problem.)
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7 At the visual checking part of the chart, check whether the gradation 
of each color is smooth.

Repeat this operation until the sufficient adjustment is made.

8 Click .

 If the adjustment looks insufficient, measure the colors on the chart printed in 
Step 6.  
Re-execute the automatic adjustment by the measurement as the fine adjust-
ment.

Also, you can adjust the each color data manually by clicking . 
( P.2-69 )

When editing the curves, click  and check the printed results. 
The image file supplied by MIMAKI is stored. (TestPrint_GrayBalance.tif) 
When you have the chart exclusively for confirmation, select the image file you 
have.

Continued on P.2-52 "ICC profile creation"
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ICC profile creation

The ICC profile is created by printing the chart and measuring the colors.
This item applies to the case when "ICM" is selected in "Color matching" of the Raster Link series.

1 Click  to print 
the chart for measurement.

( P.2-27  Steps 1 to 2)

2 Click .

When SpectroScan is selected in [Measurement]

Continued from P.2-51 "Automatic adjustment of Gray balance"
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3 Click 
.

4 The MeasureTool 5.0 is acti-
vated.

5 Measure the colors.

( P.2-29  Step 6)
Select "XX_IccProfile.txt" for the chart name. (XX is the name of the color measuring 
device.)

When ProfileMaker dongle is not used, MeasureTool5.0 is activated in 
demonstration mode. When activated in demonstration mode, DTP-41 
cannot be used. (Other color measuring device can measure the color 
without problem.)
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6 When the measurement is 
completed, click .

7 Specify the "Profile Size" and 
"Perceptual Rendering Intent" 
then click .

 Profile Size
High accuracy :

Create the more accurate ICC 
profile than [Normal] for approx-
imately 3 minutes.  
The file size of the ICC profile is 
about 2MB. 
Use this setting when creating 
the device profile with the print 
condition that it is easy to be 
grainy on printing.

Normal:
Create the ICC profile in short 
time (approximately 1 minutes). 
The file size of the ICC profile is 
about 700KB. 
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8 Adjust the black replacement.

( P.2-71 )

9 Click .

10 ICC profile creation begins.

11 Click .

Control returns to the Creation wizard 
screen.

 If wrong color measurement file is 
selected, the message shown on 
the right appears.
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12 Click  and then 
check the printed device pro-
file.

( P.2-15  Steps 2 to 5)

13 When checking has been 
completed, click .

 The image file supplied by 
MIMAKI is stored.  
(TestPrint_ICCProfile.tif) 
When you have the chart 
exclusively for confirmation, 
select the image file you 
have.

 If you set the black printer 
again, click [TestPrint] to 
check the printing contents.

When Profile (V2) is selected
Continued on P.2-60 "Device profile saving"

When Profile (V3) is selected
Continued on P.2-57 "Basic setting of calibration 
(when selecting profile (V3))"
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Basic setting of calibration (when selecting profile (V3))

Record the "base colors" to adjust the colors produced by the printer when they are different from 
the previous colors due to various factors. 
With the calibration function, adjust the changed colors produced by the printer so that they may 
look similar to the "base colors". 

1 Click  to print 
the chart for measurement.

( P.2-27  Steps 1 to 2)

 If you record the base colors in the profile, you will be able to adjust the profile so 
that it may look similar to the status recorded this time even if the colors may 
change due to temperature change or printer head adjustment. 

Before you perform the basic setting of the calibration, fully read the P.App.-6 
"Note when measuring colors"  so that you may not include an abnormal value 
in the color measuring result.

 If the recorded color measuring result in the basic setting has an abnormality, 
as the calibration cannot be performed normally, the changed colors cannot 
become similar to the "base colors".

 If you have selected CMYKOrGr ink set, this will not be displayed. 

When SpectroScan is selected in [Measurement]

Continued from P.2-56 "ICC profile creation"
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2 Click  and 
measure the printed chart.

3 Click 
.

4 The MeasureTool 5.0 is acti-
vated.

5 Measure the colors.

( P.2-29  Step 6)
Select "XX_CalibrationTarget.txt" for the chart name. (XX is the name of the color measur-
ing device.)

When ProfileMaker dongle is not used, MeasureTool5.0 is activated in 
demonstration mode. When activated in demonstration mode, DTP-41 
cannot be used. (Other color measuring device can measure the color 
without problem.)
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6 When the measurement is 
completed, click .

Continued on P.2-60 "Device profile saving"
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Device profile saving

Save the created device profile.

1 Click .

2 Specify the folder for saving 
the profile, and then enter the 
file name.

3 Click .

Control returns to the "Creation wizard".

4 Enter the creator's name.

5 Click .

When the device profile creation has 
been completed, the screen returns to 
the main menu.

Continued from P.2-56 "ICC profile creation"
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Function buttons

The explanation is the following function buttons used when creating and editing a device profile.

Test Print button, Chart Print button

These buttons are displayed in the Device Profile Creation wizard and in the dialog used to edit 
the device profile. 

?Output the required charts at the time of device profile creation.
?Select the image files and print the images applying the data that has been set. 

 Test Print button, Chart Print button ( This page)

 Import button ( P 2-67 )  Curve Edit button ( P 2-69 )

 Interrupt button ( P 2-74 )  Adjustment button (  P 2-71 )

 Read measurement file (  P 2-77 )

 The following image formats can be selected in Test Print.

 The image size of the chart used for measuring color cannot be changed. Set a 
media more than 600 mm (23.6 inch) wide. For small printers, there is a small 
chart.

 For handling media, see the User's Guide for each model. 

*. RGB color mode for TIFF and BMP can be selected only in the Test Print of the ICC profile.
*. CMYKOrGr inkset is selected, "Test Print"  is not displayed than ICC profile.

Image format Color mode

TIFF CMYK、RGB * (Images compressed with LZW cannot be       
printed)

BMP * Full color, Index color
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Preview screen

When clicking the white part in each 
item, the settings can be changed.

Layout

The layout of the output image, such 

as the size and position, is adjusted.

Print Condition

Printing conditions are set.

White Ink

When the printer that can use the 

white ink is selected, the printing 

method for white ink is set.

Color Matching

Using the completed profile, color-

matching procedures are carried out.

This item can be used after ICC profile 

is created.

Output target

Select a output target.

Input scan, feed

Display the size of the input images.

Output scan, feed

Display the size of the output images 

after the layout has been adjusted.

When the output port is "file", 
you cannot click this button.
An error occurs if you click 
the button when the printer 
and the computer are not 
connected.

Media scan, feed

Display the set media size.

When clicking [Get media 

size], retrieve the media 

size in scan and feed from 

the connected printer.

The following dialog is displayed when:The following dialog is displayed when:

Click                      .Chart print

Click                   .    Select the image to be output.Test print
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 Layout

 Scale(%)/(Scan)/(Feed)
The image size to be output is resized. Resize 
by entering the rate or value (millimeters or 
inches). 
• The ratio of size of the scan and feed direc-

tion is fixed. 
• The scale may be designated within a 

range of 25.4 to 2500mm (1 to 98.4 inches) 
or 300%. 

 Rotation
The image to be output is rotated counter-
clockwise. 
(OFF, 90 deg, 180 deg, 270 deg)

 Mirror
The image to be output is turned over horizon-
tally. (ON,OFF)

 Position (Scan)/(Feed)
Specify the distance of the image position 
from the origin designated by the printer. 
• The range in which the images can be posi-

tioned 0 to 5000mm (0 to 196.85 inch). 

When using sublimation ink or when printing on the back of the transparent 
media, make sure to use mirror function. Otherwise, the image will be reversed 
when transfer printed. However, when the original image is already reversed, 
there is no need to use the mirror function. 

When the image size exceeds the media size, and when the data is out of 
media due to positioning data, the dialog to confirm whether you wish to con-
tinue to print appears. When you redo the setting and print the images within 
the media, click  and change the setting. 

When the image exceeds the output width, the exceeded portion is not output. 
When the position of the origin is outside the output range, the image is not out-

put. 
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 Print Condition

When Chart Printing, Pass/High speed print/Print Direction/Overprint/Half tone are not dis-
played.  
These are printed using the profile conditions. 

 Pass
Set the number of passes when printing. 

 High speed print
When you wish to print quickly, select [ON]. 
(When set to [ON], the image quality is not as 
good as normal.)

 Printing direction
Select the print direction.

 Overprint
Set the number of overprints. 

 Half tone
Select the method for Half tone. 

 Label print
The device profile information is added to the 
image. 
Whether label print is used or not, or the size 
of label print can be selected. (No Print, Small 
Size, Medium Size, Large Size) 
The following information is printed.

• Date
• Output data in the adjustment stage
• Printer information (Printer name, output 

setting)
• Ink set name
• The items set in the [Label] in Option set-

tings ( P 1-9 ).
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 White Ink

It is displayed when a printer that can use the white ink is selected.
 Print method

White print off
Select this when using a media whose surface 
is white. 
White ink to Full color
Select this when using a media whose surface 
is not white.
Full color to white ink
Select this when printing on the rear surface 
of a transparent media. When this parameter 
is selected, the [Mirror] setting is automatically 
activated. 

 Density
Density of white ink is set. 

 Slot setting
Select the color setting of the slot that 
includes white ink. To confirm the color set-
ting, see the User's Guide for the printer. 

 Quality
This is the setting when color ink is drawn 
over the white ink drawing. There are LEVEL 
1 to 3. The larger the number, the longer the 
time from printing with white ink to printing 
with colored inks.  
If you make the LEVEL larger, the drying per-
formance of the white ink becomes better, but 
the time for drawing becomes longer. 

When using white ink with UJF series, JF-16XX series or JFX, the white image 
and the full color image are output in one stretch. As it is dangerous, do not 
touch the printer until the output ends completely.

 “Quality” is displayed only if you have selected an ink set that can include white 
ink, with a vertical printer.
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 Color Matching

Using the completed device profile, color matching procedures are carried out. This item is dis-
played in the test print of the ICC profile. 

 RGB input profile
This is the input profile used when an RGB 
image is output. This can be selected from the 
RGB input profile that has been installed in 
the target RIP. 

 CMYK input profile
This is the input profile used when a CMYK 
image is output. This can be selected from the 
CMYK input profile that has been installed in 
the target RIP. 

 Rendering Intent
This is to select means of color matching. 

 Rendering
This is to select the accuracy of the color 
matching processes when output with V3 pro-
file. 

 Output target

Out of the printers connected with the PC, the printer connected with the port held by the printer 
selected at the Setting of the Profile conditions ( P 2-5 ) is displayed.
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Import button

Click  during device profile creation to copy the data from the existing file to the data for 
the items being set. 
This is convenient when setting the same values as the profile that has already been created.

1 Click .

2 Select a profile to be 
imported.

3 Click .

4 The import is completed.

The confirmation dialog is displayed.

5 Click .

Specify the device profile for the import source with the following conditions: 
• Data exists for the items that are being set
• Ink with the same color as the device profile being created exists
When a device profile with conditions other than the above is designated, an 
error message appears and data cannot be imported. 

 There is no error when importing Feed correction and Heater temperature and 
when there is no data in the import source device profile. The default value will 
be set. If necessary, change the value. 
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Import Compatibility Table

When the device profile of import source and of import destination are different, some items may 
not be imported.

Media 
character

Lineariza-
tion

Ink limit
Gray 

balance
ICC profile

Variable 
dot

Light ink

V2→V3 ○ × × × ○ × ×

V3→V3 ○ ○ ○ ○ ○ ○ ○

V3→V2 ○ × × × ○ × ×

V2→V2 ○ ○ ○ ○ ○ ○ ○

Besides the above, there are the following restrictions on compatibility between 
CMYK profile and CMYKOrGr profile. 

Media 
character

Lineariza-
tion

Ink limit
Gray 

balance
ICC profile

Variable 
dot

CMYK → CMYKOG ○ × × × × ×

CMYKOG → CMYK ○ ○ ○ ○ × ○



Chapter 2 Creating a device profile     

2-69

Curve Edit button

 is function to adjust the linearization curve and the gray balance curve. 
When  is clicked, the following dialog appears.
The figure below shows the linearization curve. 
To edit curves, use the mouse and the keyboard. 
You can edit the curve indicating the control points (red). 
The control points are shown at every 5% interval. 
The color of the curve corresponds to the color of ink. 
The curve shown in a solid line can be edited. The dotted line displays the initial state of the curve 
when the dialog was opened. 

(1) Output
Display the ink value of each ink at the selected control points. 
Click the figures to edit the value. If you click the value of a curve different from the 
curve currently selected, the selection of the curve is also switched. 

(2) Input
The coordinates of the horizontal axis of the control point currently selected is dis-
played. These figures cannot be changed. 
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How to edit a curve

Operations with the mouse

Operations with the keyboard

Operation Explanation

Left-click the control point of the     
selected curve

The selected control point turns red.

Double left-click the control point of     
the selected curve

The control point is deleted. 
This is used when you want to edit over a wider range. 

Left-click the selected control point    
with the curve disappeared (Left-    
click the crossing point of the curve      
and the auxiliary line coming from     
the horizontal axis)

The deleted control point is restored.

Drag the control point of the     
selected curve

The control point is moved up and down. 
The control point does not move sidewise. 
While dragging, the control point moves up and       
down according to the movement of the mouse       
cursor in the curve editing area. 

Right-click within the curve editing    
area

A pop up menu displays the following 6 functions        
for the curve displaying the control point:

• Reset 
Return to the shape when the curve editing dialog        
was opened.

• Identity 
Make a straight line (curve) of 0 to 100%.

• Gamma 
Make the curve with a gamma value. Displays a        
dialog for inputting the gamma value. 

• Minimum 
The whole curve is made to the lowest value. 

• Copy 
Copy the selected curve on the memory.

• Paste 
Overwrite the curve copied on the memory with       
the selected one. This function becomes     
selectable, when perform the copy. 

Left double-click the curve not selected. Changes the selection of the curve.

Operation Explanation

 ，  key Moves the selected control point up and down.

 ，  key
Moves the selection of the selected control point. 
When the control point does not exist on the curve,         
moves while adding the control points. 

 +  ，  key
Changes the selection of the curve.
The curve may be selected in the order indicated in         
the list of output values. 
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Adjustment button

Clicking on , "Improvement on Yellow" and "Black Replacement" can be set.

Improve impure Yellow

This avoids the phenomenon Cyan mixing with Yellow. The Yellow is hold at a constant hue with-
out tone jump. 

1 Click  in the ICC 
profile creation screen. 

2 Click .

The improvement on yellow is automat-
ically processed. 

3 Click .

When setting both "Improvement on Yellow" and "Black Replacement" are set, 
set Black Replacement before the Improvement on Yellow. If these are set in 
the reverse order, the process for improving impure yellow becomes invalid. 
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Black Replacement

Set for replacing the gray component when C+M+Y are mixed with K ink. Adjusting black replace-
ment is effective in shadow areas, etc., when an excess ink value overflows, or the black printing 
is desired to be kept. 
Replacement with K ink set here will become valid when the color matching and ICM are turned 
ON with the Raster Link series. 

1 Click  in the ICC 
profile creation screen. 

2 Click .
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3 Perform the setting of 
each item.

(1) Separation
Change the balance between a 
quantity of black ink and quantity of 
CMY inks to replace with black ink 
in the gray scale.

(2) Max Black
Set the quantity of black ink in the 
case of the darkest color.

(3) Define Black Point
Set the quantity of each CMYK ink 
at the darkest color. The "Total" is 
the added value of the quantity of 
each CMYK ink.

(4) Neutralize
With the use of "Separation", "Max Black" and "Define Black Point", the distorted gray 
color will be automatically adjusted. Click after completing each setting. 

(5) Start Black
The density of black ink started to be contained is designated. 
If you set this to 40 to 60, the granular feeling of the highlight of Black dots will disappear. 

4 When finishing the setting, click .

Creates an ICC profile. 

5 Click .

 In case that gray is expressed with CMY, if you increase the value of K ink, 
granularity may be felt in the highlighted portion or initial portion where K ink is 
entering, but the hue in the medium tone is better. Although slightly, K ink has a 
nature to be tinged yellowish or reddish, make sure not to increase value of K 
ink, if you want to output bluish gray. 
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Interrupt button

 is a function to save a device profile which has been created halfway (interrupt file).
The Interrupt button is displayed on every screen of the Creation wizard. 
The file extension of the interrupt file is "*.chocot". 
The interrupt file can be restarted by Resume ( P 2-75 ). 
The Interrupt file (*.chocot) cannot be installed with the Raster Link series.

1 Click .

The dialog to confirm interruption of 
profile creation appears. 

2 Click .

The dialog to save the interrupt file 
appears. 

3 Specify the folder for saving 
the profile, and then enter the 
file name.

4 Click .

The dialog to confirm exiting the Cre-
ation wizard appears.

5 Click .

The screen returns to the main menu.
When you continue to create the pro-
file, click .
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Resume

Opens the file saved in ( P 2-74 ) and completes the device profile creation.

1 Select the [Device Profile] tab 
and click "Resume".

The Creation wizard will appear.

2 Click .

Open the interrupt file to be resumed. 
The only selectable file extension is 
"*.chocot". 

3 Select the file and click 
.
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4 Click .

5 Confirm the creation condi-
tions.

6 Click .

The screen displays the Creation wiz-
ard interrupted on the way.

7 Resume the device profile creation.

When either the interrupt file created by the trial version or the interrupt file in 
which the media deleted from MPM II is specified, the media selection screen 
appears. Select the media and click .

 The following procedures are the same as the those in the "Creation wizard 2". 
( P 2-7 )
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Read measurement file

On the measurement screen of the Linearization/Gray Balance/ICC profile, the measurement that 
has already been saved can be read and used for the measurement of the profile you are creating.

1 On the measurement screen, click .

2 Click 
.

3 Select the file to read the mea-
surement and click .

4 Click .
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Flow of the Device Profile editing

 Select [Edit]  P 3-3 

 Adding the profile to be edited to the list.  P 3-4 
Add device profile you want to edit to the editing list.

 Editing a device profile  P 3-6 
Edit the registered device profile.
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Select [Edit]

1 Select the [Device Profile] tab.

2 Click "Edit".

The edit list is appears.

Continued on P.3-4 "Adding the profile to be edited to the list."
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Adding the profile to be edited to the list.

1 Click "Open".

2 Select the device profile to 
edit.

To select more than one device profile, 
hold down the Ctrl key while clicking 
the left mouse button.

3 Click .

The selected profiles are added to the edit list.

Continued from P.3-3 "Select [Edit]"
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Edit list

The added device profile is displayed.
The amount of ink that is consumed when a device profile is selected and used for printing can 
also be calculated.

(1) Open Adds a device profile to the list. ( P.3-4 ) 
Only profiles for use with the Raster Link series can be opened.

(2) Edit Edits the device profile selected in the edit list.
(3) Copy Creates a new device profile with different parameters based on the          

device profile selected in the list.  ( P.5-2 "Copy wizard")
(4) Delete Deletes the selected device profile from the profile list.
(5) Back The screen returns to the main menu.
(6) Set Basis The target information for using the calibration and equalization        

functions are registered. Valid only with V3 profile. 
( P.4-3 "Recording the base colors (Set Basis)")

(7) Calibration When the colors of the printer have changed, adjust to the colors           
recorded on "Set Basis". Effective only with the V3 profile in which the            
target information is recorded on "Set Basis".( P.4-5 "Performing       
calibration")

(8) Equalization When more than one printer of the same type is used, approximate           
the colors between the printers. Effective only with the V3 profile in           
which the target information is recorded on "Set Basis".( P.4-14        
"Performing Equalization")

(9) Replacement The information for calculating the color information such as color         
collection of Raster Link Pro III or later in Raster Link series is            
recorded. Valid only with V3 profile.

Select [Ink consumption] from the View menu 
to calculate the ink value consumed when the 
selected profile is used. ( P.3-17 )

When you click on the item name (column) on the 
top line of the list, you can perform sorting with the 
information of that line.
Further, when you right-click on the column, you 
may change the contents to be displayed on the list.
If you check on the information you wish to display, 
it is added to the display of the list and if such check 
is removed, its display is also deleted.

Continued on P.3-6 "Editing a device profile"
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Editing a device profile

1 Select the device profile to edit and click "Edit".

The “Profile edit” window appears.

2 Double-click the editing contents of the device profile.

The number of items and the substance 
of editing vary depending on the device 
profile.

For details, refer to P 3-8 .

3 Select the item to be edited.

Select the tab, and make editing in the 
same manner as preparing the profile 
creation.

 If you adjust the linearization, the smoothness of gradations may be affected 
and C+M+Y gray that is printed using a Raster Link series (with color matching 
ON and gray balance ON) may appear with a tinge of color.  
If this happens, reaadjust the gray balance so that the gray is reproduced cor-
rectly.

Continued from P.3-4 "Adding the profile to be edited to the list."
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4 Click  when you have 
finished making changes.

The screen of step2 appears.
When editing other route in a row, dou-
ble-click it.

5 After editing all, click .

"Setting to save profile" screen 
appears.

6 Enter the profile name and 
path, and creator's name, and 
then click .

The screen returns to the edit list 
screen.

 If you are editing and saving a device profile that was 
created by someone else, select the media name.

 The profile editor allows you to save device profiles under a different name.  
In this case, device profile parameters such as the printer, ink set, resolution, and 
media name are exactly the same as the original device profile. 

 In Raster Link Pro, device profiles that are installed later overwrite previously 
installed device profiles. (When installed simultaneously, we do not guarantee 
which one is installed first.)  Take care when installing device profiles in Raster Link 
Pro.

 In Raster Link series other than Raster Link Pro series, it is possible to use Profile-
Manager to choose between using existing device profiles and device profiles that 
are installed later.
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 List of Editing Items

 Edit an ICM route

 Edit a graybalance route

V2 profile V3 profile

ICM route Graybalance 
route V3 profile Calibration Equalization

Ink limit ○ ○ ○

ICC profile ○ ○

Media character setting

Feed correction ○ ○ ○

Heater temperature ○ ○ ○

Feed setting ○ ○ ○

Dot size ○ ○ ○

Top Blower ○

Feed Direction ○

Extended information UV illumination ○

Variable dot ○ ○ ○

Gray balance ○ ○

Linearization ○ ○

Light ink ○ ○ ○

Ink limit adjustment ○ ○

Automatic adjustment of Linearizaion ○ ○

Automatic adjustment of Gray balance ○ ○

Confirm delta E ○ ○



Chapter 3 Editing a device profile     

3-9

 Edit a V3 profile

 Edit a calibration/Equalization

Explanation
Reference 

page

Adjust the quantity of each ink. P 3-10 

Perform adjustment, import, etc. of ICC Profile. P 3-10 

Check "Switch a Feed correction setting on/off" to adjust the media correction value. P 3-10 

Check "Switch heater settings on/off" to adjust the heater temperature. P 3-11 

Check "Switch a Feed speed setting on/off" to adjust the media feeding speed. P 3-11 

The dot size can be adjusted when JF-16XX series, UJV-160, JFXUJF-706, UJF-3042FX, UJF-3042HG,            
UJF-6042 or Tx400 is set on the printer. (When the printer is set to JV3, the editing of dot size cannot be                     
performed.)

P 3-11 

The air volume of Top Blow can be changed when JV300 or CJV300 are set on the printer. P 3-12 

When UJF-3042FX, UJF-3042HG or UJF-6042 is set on the printer and the CMYKLcLm color set is set on                 
the ink set, you can change the feed direction.

P 3-12 

The UV lamp’s shine mode can be changed by changing the “UV lamp settings”. P 3-12 

Parameter of the variable dots is displayed. (Only when variable dots is selected).  
This item is not for editing.

-

The curve of each ink is adjusted. P 3-12 

The curve of each ink is adjusted. P 3-13 

The setting of light ink being currently used is displayed. (Only when light ink is selected). 
This item is not for editing.

-

The quantity of each ink is automatically adjusted. P 3-13 

The curve of each ink is automatically adjusted. P 3-13 

The curve of each ink is automatically adjusted. P 3-14 

P 3-14 

Can be edited only when profiles set 
with Calibration Function( P.4-2 ) 
or Equalization Function( P.4-13 ) 
are selected.
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Editing the Ink limit

Click the [Ink limit] tab to display the following screen.

Editing the ICC profile

Click the [ICC profile] tab to display the following screen.

Editing the Media character setting

Click the [Media character setting] tab to display the following screen. 
The items that can be edited on this tab vary depending on the profile. 

Editing the Feed correction

Edit referring to P.2-7 .

In the case of V2 Profile
For editing method, refer to P.2-22 .

In the case of V3 Profile
For editing method, refer to P.2-45 .

Print out referring to P.2-15 .

Make adjustment 
referring to P.2-71 .

This function is almost the same as . You can 
select files that have a file extension of .cot, .icm or .icc.
Make adjustment referring to P.2-67 .
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Editing the Heater temperature

Edit referring to P.2-7 .

Editing the Dot size

Edit referring to P.2-8 .

Editing the Feed setting

Edit referring to P.2-11 .

Editing the Top Blower

Edit referring to P.2-11 .

You can edit the dot size 
for JF-16xx series, UJF-
160, JFX, UJF-706, UJF-
3042FX, UJF-3042HG, 
UJF-6042 and Tx400.

You can edit the Top 
Blower for JV300 and 
CJV300.
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Editing the Feed Direction 

Edit referring to P.2-11 .

Editing the Extended information

Click the [Extended information] tab to edit the information.

UV illumination

Edit referring to P.2-13 .

Editing the Gray balance

Click the [Gray balance] tab to display the following screen.

You can edit the Feed 
Direction for UJF-
3042FX, UJF-3042HG, 
and UJF-6042.

Refer to P.2-69 .

Refer to P.2-67 .
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Editing the Linearization

Click the [Linearization] tab to display the following screen.

Editing the Ink limit adjustment (Calibration / Equalization Editing Screen)

Click the [Ink limit adjustment] tab to display the following screen.

Editing the Auto linearization (Calibration/Equalization Editing Screen)

Click the [Auto linearization] tab to display the following screen.

Refer to P.2-67 .

Refer to P.2-69 .

Refer to P.2-28 .

Refer to P.2-18 .

Refer to P.2-28 .

Refer to P.2-18 .

Refer to P.2-69 .
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Editing the Auto gray balance (Calibration/Equalization Editing Screen)

Click the [Auto gray balance] tab to display the following screen.

Confirm delta E (Calibration/Equalization Editing Screen)

Click the [Confirm delta E] tab to display the following screen.

Refer to P.2-28 .

Refer to P.2-18 .

Refer to P.2-69 .

Refer to P.2-28 .

Refer to P.2-18 .

Print out referring to P.2-15 .
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Replacement
Raster Link Pro III or later in Raster Link series enables to replace the colors by calculating auto-
matically the color approximate to the desired one using the color collection and scanner color 
measuring function. The information used for the calculation of color replacement will be taken 
from the profile. 

In MPM II, the information used for color replacement can be added to V3 profile. 

Adding Replacement

1 Select the [Device Profile] tab 
and click "Edit".

The edit list is displayed.

2 Add to the editing list the V3 
profile.

 P.3-4 "Adding the profile to be edited to the list."

3 Click "Replacement".

Generating wizard of high accuracy 
Replacement appears.

4 Output the chart and create 
the ICC profile.

 P.2-52 "ICC profile creation"

When Replacement is added to the newly made V3 profile, perform it when 
editing of the profile is finished completely.

 "Replacement" is overwritten and recorded on the selected V3 profile. It is rec-
ommended to take a back-up of the profile in advance. 
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5 Click .

6 Click .
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Ink consumption
Ink value that is consumed when a device profile is selected and used for printing can be calcu-
lated.

1 Open the edit list by referring to "Adding the profile to be edited to 
the list." ( P.3-4 ).

2 Select the device profile with which you want to calculate the ink 
consumption.

3 Select "View" - "Ink consumption".

4 Select the data for which you want to calculate the ink consumption when it is 
printed using the selected device profile, then click .

When you want to calculate the quantity of ink consumption of the file actually output-
ting, select [Operation] tab in P.1-9  “Option” and check on “Calculate ink consump-
tion”. When the printing is completed, the ink consumption will be displayed.



3-18

5 Set the print conditions and click .

The dialog shown on the right is dis-
played, and the expected ink consump-
tion is calculated. 

6 Check the calculated ink con-
sumption, then click .

You can click  to save the calculated value.



 Calibration/equalization cannot be carried out with CMYKOrGr ink set profile.

Chapter 4 
　Calibration and equalization  

The execution procedure and operation of calibration and 
equalization function are explained.

Calibration Function ................................................. 4-2
Recording the base colors (Set Basis) ...........................4-3
Performing calibration .....................................................4-5

Equalization Function ............................................ 4-13
Performing Equalization ................................................4-14

About operation of calibration/equalization ......... 4-21
Check the daily color difference ....................................4-21
Re-adjust the calibration data .......................................4-24
Add new calibration data ..............................................4-28
Print by using calibration data .......................................4-29
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Calibration Function
When you print with an inkjet printer, the colors produced by the printer may differ due to   the fol-
lowing factors:

If you recorded the "base color", you will be able to adjust the profile so that it may look similar to 
the "base colors" recorded in advance even if the colors produced by the printer changed due to 
temperature change etc.

Variation of 
temperature and 
humidity

Ink and media are affected and make an impact to colors.

Adjustment or 
replacement of the 
printer head

The change of the head could result in colors different from          
the previous ones.

 The profile corrected by calibration function can be used with Raster Link Pro III 
or later in Raster Link series. 

 The calibration function can be used only with V3 profile (files with extensions 
of .icc). 

Calibration cannot be carried out correctly with a profile converted from V2 to 
V3 using the ProfileManager provided in Raster Link ProIII to RasterLinkPro5. 

 To use calibration function, it is necessary to make "Set Basis" in advance. 

 The calibration function performs adjustment for each profile.  
As the spreading of the dot (dot gain) varies depending on the ink and the 
media, and the drying property of the ink varies depending on resolution and 
the number of pass, different adjustment is required for each profile.  
When the most frequently used profile is decided, perform the "Set Basis". 
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Recording the base colors (Set Basis)

Record the "base colors" to adjust the colors produced by the printer when they are different from 
the previous colors due to various factors. 
The calibration function can adjust the changed colors produced by the printer so that they may 
look similar to the "base colors" recorded here. 
If you recorded the "base colors" when you created the profile, it is not required to perform basic 
setting.

1 Select the [Device Profile] tab 
and click "Edit".

The edit list is displayed.

2 Add to the editing list the V3 
profile on which the base colors are recorded.

 P.3-4 "Adding the profile to be edited to the list."

3 Click "Set Basis".

Set Basis wizard of calibration is acti-
vated.

4 Output the chart and measure 
the colors.

Refer to P.2-27 "Automatic adjustment    
of Linearizaion" steps 1 to 6.
Select "XX_CalibrationTarget.txt" for 
the chart name. (XX is the name of the 
color measuring device.)

 "Set Basis" is overwritten and recorded on the selected V3 profile. It is recom-
mended to take a back-up of the profile in advance. 
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5 Click .

6 Click .

The edit list will be displayed.



Chapter 4 　Calibration and equalization    

4-5

Performing calibration

When the colors produced by the printer you are using are different from the previous colors, the 
three factors of ink limit, linearization and gray balance are adjusted using the V3 profile recorded 
in "Set Basis".

Measure the color under the current condition

1 Select the [Device Profile] tab 
and click "Edit".

The edit list is displayed.

2 Add the V3 profile on which 
the basic setting has already 
been performed to the edit 
list.

 P.3-4 "Adding the profile to be      
edited to the list."

3 Click "Calibration".

Calibration wizard appears.

4 Output the chart and measure the colors.

Refer to P.2-27 "Automatic adjustment of Linearizaion" steps 1 to 6.
Select "XX_CalibrationTarget.txt" for the chart name. (XX is the name of the color measur-
ing device.)

 The adjustment made by calibration is overwritten and stored in the selected 
V3 profile. It is recommended to take a back-up of the profile in advance. 

 For the calculation of color difference, D50 light source is assumed. Accord-
ingly, the same results cannot necessarily be obtained with the light source in 
your environment. You are requested to tolerate the difference between what it 
looks and the figures. 

When the "Calibration" is made invalid, first perform the "Set Basis". 
( P.4-3)
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5 Click .

After a few seconds, the screen pro-
ceeds automatically. 
Wait for a moment. 

6 Confirm the value of color dif-
ference.

The difference between the recorded 
basic setting and the current color 
measuring result is displayed.
For the details of color difference fig-
ures, refer to Glossary.  
( P.App.-3)

When performing calibration, click .

When not performing calibration, click . The edit list will be displayed.

 To check color difference value, select "Display method of color differ-
ence" on the lower right of the screen. 

 For the display method of color difference, there are ΔE, ΔE94 and 
ΔE2000, however, we recommend "ΔE2000" because it is the most 
similar to the color difference that human's eyes feel.

When the color difference is [6] or above,   mark is displayed. It is recom-
mended to perform calibration when  mark is displayed.

Calibration can be performed even if the  mark is not displayed. Perform 
calibration as necessary.

When there are many  marks or when the numerical values are high, per-
form adjustment of the printer.



Chapter 4 　Calibration and equalization    

4-7

7 Select the contents of the work and click .

Adjusts the linearization of each 
inks. (Basic)

Only CMYK’s gradation adjust-
ment will be performed. 
(The work for around 30 minutes.)

Adjusts the linearization, the hue of 
RGB and graybalance. (Advanced)

The adjustment of three factors of fine 
tuning of the hue of secondary colors, 
sequence of gradation, gray balance 
color adjustment are performed. (The 
work for around two hours.)

 The work selected here (Normal/Advanced) cannot be changed on the 
way.

 The color differences caused by making adjustment of the printer are due to 
changes in dot overlapping. As the mixing of colors varies when the overlapping 
of the dots are changed, it will affect to secondary or tertiary colors.  
When you made the adjustment of the printer, please perform the calibration in 
detail mode.

When (Normal) is selected, Continued on P.4-8.
When (Advanced) is selected, Continued on P.4-10.
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When the work (Normal) is selected

1 Automatic adjustment of linearization will be performed.

Output the chart and measure the col-
ors.
Refer to P.2-27 "Automatic adjustment of Linearizaion" steps 1 to 6.
Select "XX_Linearization.txt" for the chart name. (XX is the name of the color measuring 
device.)

2 Click .

3 Perform curve editing when 
necessary.

When editing of the curve is necessary, 
click .
For editing method, refer to P.2-69 
"Curve Edit button".

4 Select the [Confirm delta E] 
tab.

The color difference before performing 
calibration is displayed on the screen.

5 Output the chart and measure 
the colors.

By measuring colors of the chart on 
which the adjustment result is reflected, 
check the calibration result.
Refer to P.2-27 "Automatic adjustment    
of Linearizaion" steps 1 to 6.

When the curve after adjustment is wound greatly or is in the form of S-curve, 
there could be the mistake in the color measuring. Make the curve straight, and 
repeat the color measuring again.

Continued from P.4-7 “Measure the color under the current condition”
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6 Click .

7 Confirm the color difference after adjustment.

8 Click .

9 Enter the Comment.(Max. 20 
characters)

The comment is displayed when used 
with Raster Link ProIII or later in Raster 
Link series. Make it simple and easy to 
understand.

10 Click .

The calibration data is added to V3 pro-
file, which is overwritten and stored.

As the measured color values include measuring errors, the values will vary 
each time you measure the color. Further, the value of color difference will also 
be varied. 

 The color measuring errors have the following factors:
a. Individual difference of color measuring deviceb.
b. Repeating accuracy of the measuring devicec.
c. Unevenness of the printed materiald.
d. Distance between the printed material and color measuring device or the 

manner of contacting.
 The color measuring error by color measuring device is below 1 in delta E.  

When the value of color difference is greater than what you look, check if there 
is any nozzle missing or unevenness on the printed material, and repeat the 
color measurement.
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When the work (Advanced) is selected

1 Adjust the hue of the second-
ary colors.

Output the chart and measure the col-
ors.
Refer to P.2-27 "Automatic adjustment    
of Linearizaion" steps 1 to 6.
Select "XX_CalibrationTarget.txt" for 
the chart name. (XX is the name of the 
color measuring device.)

2 Click .

The amount of ink will be adjusted 
automatically.

3 Click .

4 Automatic adjustment of lin-
earization will be performed.

Output the chart and measure the col-
ors.
Refer to P.2-27 "Automatic adjustment    
of Linearizaion" steps 1 to 6.
Select "XX_Linearization.txt" for the 
chart name. (XX is the name of the 
color measuring device.)

 The adjustment here is to make fine tuning. When the amount of ink 
has varied greatly (such as 90% or less), there is possibility of mea-
suring mistake.  
Return the amount of ink to 100%, and make color measuring again.

Continued from P.4-7 “Measure the color under the current condition”
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5 Click .

6 Click .

7 Automatic adjustment of the 
gray balance will be per-
formed.

Refer to P.2-49 "Automatic adjustment    
of Gray balance".
Select "XX_GrayBalance001.txt" for 
the chart name. (XX is the name of the 
color measuring device.)

8 Click .

9 Select the [Confirm delta E] 
tab.

The color difference before performing 
calibration is displayed on the screen.

When the color difference becomes greater due to adjustment of linearization, 
straighten all curves with .(Make to the state no calibration is 
made.)

When the color difference becomes greater due to adjustment of gray balance, 
straighten all curves with .(Make to the state no calibration is 
made.)
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10 Output the chart and measure the colors.

By measuring colors of the chart on which the adjustment result is reflected, check the 
calibration result.
Refer to P.2-27 "Automatic adjustment of Linearizaion" steps 1 to 6.
Select "XX_CalibrationTarget.txt" for the chart name. (XX is the name of the color measur-
ing device.)

11 Click .

12 Confirm the color difference after adjustment.

13 Click .

14 Enter the Comment. 
(Max. 20 characters)

The comment is displayed when used 
with Raster Link ProIII or later in Raster 
Link series. Make it simple and easy to 
understand.

15 Click .

The calibration data is added to V3 pro-
file, which is overwritten and stored.

As the measured color values include measuring errors, the values will vary 
each time you measure the color. Further, the value of color difference will also 
be varied. 

 The color measuring errors have the following factors:
a. Individual difference of color measuring deviceb.
b. Repeating accuracy of the measuring devicec.
c. Unevenness of the printed materiald.
d. Distance between the printed material and color measuring device or the 

manner of contacting.
 The color measuring error by color measuring device is below 1 in delta E.  

When the value of color difference is greater than what you look, check if there 
is any nozzle missing or unevenness on the printed material, and repeat the 
color measurement.
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Equalization Function

Even if output with multiple printers of the same type, the obtained colors could be different due to 
special characteristics of each printer. 
In the case of MPM II, the correction of profile can be made so that the same output result may be 
obtained by multiple printers used under the same output condition.

 Items to be conformed as output conditions

Kind of printer Kind of Ink Composition of ink set Media used

Resolution Dot size to be used (ND or VD) Number of pass

Printing direction On/Off of high speed printing
Number of 
overprinting

 The profile corrected by equalization function can be used with Raster Link Pro 
III or later in Raster Link series. 

 The equalization function can be used only with V3 profile (files with extension 
of .icc).

When the output condition is different, it is possible that the good results are not 
obtained.

Equalization cannot be carried out correctly with a profile converted from V2 to 
V3 using the ProfileManager provided in Raster Link ProIII to RasterLinkPro5. 

 To use equalization function, it is necessary to make "Set Basis" in advance. 
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Performing Equalization

Outputting to the target printer

First, record the status of the target printer.

1 Connect the target printer with PC.

2 Select the [Device Profile] tab 
and click "Edit".

The edit list is displayed.

3 Add the V3 profile on which the basic setting has already been per-
formed to the edit list.

 P.3-4 "Adding the profile to be edited to the list."

4 Click "Equalization".

Equalization wizard appears.

Prepare in advance the V3 profile on which the "Set Basis" are recorded. 
 The contents adjusted by equalization are overwritten and saved on the 

selected V3 profile. It is recommended to take a back-up of the profile in 
advance. 

 For the calculation of color difference, D50 light source is assumed. Accord-
ingly, the same results cannot necessarily be obtained with the light source in 
your environment. You are requested to tolerate the difference between what it 
looks and the figures. 

When the "Equalization" is made invalid, first perform the "Set Basis". 
( P.4-3)
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5 Select V3 profile for outputting to the printer to be targeted.

1 Click .
2 Select V3 profile and click 

.
3 Click .

6 Measure the colors under the 
current condition of the target 
printer.

Output the chart and measure the col-
ors.
Refer to P.2-27 "Automatic adjustment    
of Linearizaion" steps 1 to 6.
Select "XX_CalibrationTarget.txt" for 
the chart name. (XX is the name of the 
color measuring device.)

7 Click .

8 Click .

 The profile selected here will not be affected by the adjustment results of 
Equalization.

When multiple number of printers is connected, make sure to select 
the target printer as output destination.

Continued on P.4-16 “Outputting to the printer to perform Equalization”
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Outputting to the printer to perform Equalization

1 Connect the printer to which you wish to make Equalization with the 
PC.

2 Measure the color under the 
current condition of the 
printer to perform Equaliza-
tion.

Output the chart and measure the col-
ors.
Refer to P.2-27 "Automatic adjustment    
of Linearizaion" steps 1 to 6.
Select "XX_CalibrationTarget.txt" for 
the chart name. (XX is the name of the 
color measuring device.)

3 Click .

When multiple number of printers is connected, make sure to select 
the printer for Equalization as output destination.

Continued from P.4-15 “Outputting to the target printer”
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4 Confirm the color difference 
before adjustment.

The difference between the recorded 
basic setting and the current color 
measuring result is displayed.
For the details of color difference fig-
ures, refer to Glossary.  
( P.App.-3)

When performing equalization, click .

When not performing equalization, click . The edit list will be displayed.

5 Adjust the hue of the second-
ary colors.

Referring to steps 1 to 6 of P.2-27 
"Automatic adjustment of Linearizaion",   
perform the chart printing and color 
measuring.
Select "XX_CalibrationTarget.txt" for 
the chart name. (XX is the name of the 
color measuring device.)

 To check color difference value, select "Display method of color differ-
ence" on the lower right of the screen. 

 For the display method of color difference, there are ΔE, ΔE94 and 
ΔE2000, however, we recommend "ΔE2000" because it is the most 
similar to the color difference that human's eyes feel.

When the color difference is [6] or above,   mark is displayed. It is recom-
mended to perform equalization when  mark is displayed.

Equalization can be performed even if the  mark is not displayed. Perform 
calibration as necessary.

When there are many  marks or when the numerical values are high, per-
form adjustment of the printer.

When the different ink or different profile is targeted,  marks could 
be displayed many times or the numerical number could become 
large. It is impossible to approximate the profiles with basically differ-
ent colorings.
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6 Click .

The amount of ink will be adjusted 
automatically.

7 Click .

8 Automatic adjustment of lin-
earization will be performed.

Referring to steps 1 to 6 of P.2-27 
"Automatic adjustment of Linearizaion",   
perform the chart printing and color 
measuring.
Select "XX_Linearization.txt" for the 
chart name. (XX is the name of the 
color measuring device.)

9 Click .

10 Click .

When Equalization is made targeting different ink or different profile, 
the quantity of ink could vary greatly. In such a case, the results will 
not be approximated as sufficient density cannot be obtained.
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11 Automatic adjustment of the 
gray balance will be per-
formed.

Output the chart and measure the col-
ors.
Refer to P.2-49 "Automatic adjustment    
of Gray balance".
Select "XX_GrayBalance001.txt" for 
the chart name. (XX is the name of the 
color measuring device.)

12 Click .

13 Select the [Confirm delta E] 
tab.

The color difference before performing 
equalization is displayed on the screen.

14 Output the chart and mea-
sure the colors.

By measuring colors of the chart on which the adjustment result is reflected, check the 
equalization result.
Refer to P.2-27 "Automatic adjustment of Linearizaion" steps 1 to 6.
Select "XX_CalibrationTarget.txt" for the chart name. (XX is the name of the color measur-
ing device.)

15 Click .
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16 Confirm the color difference after adjustment.

17 Click .

18 Enter the Comment. 
(Max. 20 characters)

The comment is displayed when used 
with Raster Link ProIII or later in Raster 
Link series. Make it simple and easy to 
understand.

19 Click .

The calibration data is added to V3 profile, which is overwritten and stored.

As the measured color values include measuring errors, the values will vary 
each time you measure the color. Further, the value of color difference will also 
be varied. 

 The color measuring errors have the following factors:
a. Individual difference of color measuring deviceb.
b. Repeating accuracy of the measuring devicec.
c. Unevenness of the printed materiald.
d. Distance between the printed material and color measuring device or the 

manner of contacting.
 The color measuring error by color measuring device is below 1 in delta E.  

When the value of color difference is greater than what you look, check if there 
is any nozzle missing or unevenness on the printed material, and repeat the 
color measurement.

 Install the device profile used at the steps of P.4-14 "Outputting to the target 
printer" to Raster Link ProIII series connected with the target printer. 

 Install the device profile to which Equalization was made to Raster Link ProIII 
series connected with the printer to which Equalization was performed. 

Perform outputting to the target printer normally, and to the printer to which 
Equalization is made selecting the Equalization factors. 
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About operation of calibration/equalization
Check the daily color difference

The procedures for creating calibration data and checking color difference later are explained.

1 Select the [Device Profile] tab 
and click "Edit".

The edit list is displayed.

2 Add the V3 profile with cali-
bration data whose color difference you wish to check to the edit 
list.

 P.3-4 "Adding the profile to be edited to the list."

3 Click "Edit".

The editable items are displayed in the 
list.

What is calibration data? 
It is correcting information of the V3 profile created with the calibration function/
the equalization function. By specifying calibration data and performing color 
conversion, you can print by reflecting calibration.
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4 Double-click the calibration 
data name whose color differ-
ence you wish to check.

The color difference when you created 
the calibration data is displayed in the 
[Checking color difference] tab.

5 Output the chart and measure 
the colors.

Refer to P.2-27 "Automatic adjustment of Linearizaion" steps 1 to 6.
Select "XX_CalibrationTarget.txt" for the chart name. (XX is the name of the color measur-
ing device.)

6 Click .

The color difference is updated to the 
current one.

After checking the color difference, if it 
is required to perform re-adjustment 
with calibration function or equalization 
function, operate the procedures in P.4-
24.

7 Click .
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8 Click .

The color difference calculated in this 
time is updated and saved.

Refer to P.3-6 "Editing a device profile"      
steps 5 to 6.

 The history of color difference is not saved. If you wish to keep the precious 
color difference, save the device profile with another name or cancel it.
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Re-adjust the calibration data

1 Select the [Device Profile] tab 
and click "Edit".

The edit list is displayed.

2 Add the V3 profile with the 
calibration data to adjust to the edit list.

 P.3-4 "Adding the profile to be edited to the list."

3 Click "Edit".

The editable items are displayed in the 
list.

4 Double-click the calibration 
data name to adjust.

When the value of the color difference is two or below, the color difference may 
become wider due to measurement error or calculation error in some cases. 

 The calibration data is overwritten and saved. Be careful because the previous 
data does not remain. 
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5 Automatic adjustment of lin-
earization will be performed.

Output the chart and measure the col-
ors.
Refer to P.2-27 "Automatic adjustment    
of Linearizaion" steps 1 to 6.
Select "XX_Linearization.txt" for the 
chart name. (XX is the name of the 
color measuring device.)

6 Click .

7 Automatic adjustment of the 
gray balance will be per-
formed.

Refer to P.2-49 "Automatic adjustment    
of Gray balance".
Select "XX_GrayBalance001.txt" for 
the chart name. (XX is the name of the 
color measuring device.)

8 Click .
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9 Check the color difference.

The previously set result is displayed 
on the screen.
Output the chart and measure the col-
ors.
Refer to P.2-27 "Automatic adjustment    
of Linearizaion" steps 1 to 6.
Select "XX_CalibrationTarget.txt" for 
the chart name. (XX is the name of the 
color measuring device.)

10 Click .

The color difference is updated to the 
current one.

11 Confirm the color difference after adjustment.

12 Click .

As the measured color values include measuring errors, the values will vary 
each time you measure the color. Further, the value of color difference will also 
be varied. 

 The color measuring errors have the following factors:
a. Individual difference of color measuring deviceb.
b. Repeating accuracy of the measuring devicec.
c. Unevenness of the printed materiald.
d. Distance between the printed material and color measuring device or the 

manner of contacting.
 The color measuring error by color measuring device is below 1 in delta E.  

When the value of color difference is greater than what you look, check if there 
is any nozzle missing or unevenness on the printed material, and repeat the 
color measurement.
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13 Click .

Refer to P.3-6 "Editing a device profile"      
steps 5 to 6.
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Add new calibration data

The procedures to add the calibration data newly are explained. 
By adding calibration data newly, you can leave the calibration data as the history.

1 Select the [Device Profile] tab 
and click "Edit".

The edit list is displayed.

2 Add the V3 profile with the 
calibration data to adjust to the edit list.

 P.3-4 "Adding the profile to be edited to the list."

3 Click "Calibration" or "Equal-
ization".

4 Output the chart and measure 
the colors.

Refer to P.2-27 "Automatic adjustment of Linearizaion" steps 1 to 6.
Select "XX_CalibrationTarget.txt" for the chart name. (XX is the name of the color measur-
ing device.)

5 Click .

6 Check the color difference.

7 Perform calibration or equal-
ization.

 When you perform calibration, refer to P.4-5 "Performing calibration".
 When you perform equalization, refer to P.4-14 "Performing Equalization".

 The chart is output with the device profile uncorrected with the existing 
calibration data.
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Print by using calibration data

The procedures to print with the device profile corrected with calibration data are explained.

1 Select the [Device Profile] tab 
and click "Edit".

The edit list is displayed.

2 Add the V3 profile with the 
calibration data to adjust to the edit list.

 P.3-4 "Adding the profile to be edited to the list."

3 Click "Edit".

The editable items are displayed in the 
list.

4 Double-click the calibration 
data name.
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5 Click .

Print by referring to the Page 2-11.
It will be printed after it is corrected with 
calibration data.
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Copying device profiles ........................................... 5-2
Copy wizard ....................................................................5-2
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Copying device profiles
If you are creating device profiles that use print conditions and media that have similar characteris-
tics, you can copy an existing device profile, then modify only the printing condition settings and 
save the profile.

The profile copy function allows you to edit the printer, ink set, resolution, media name, and media 
character settings (Feed correction value and Heater temperature, etc.).

Copy wizard

1 Select the [Device Profile] tab 
and click "Copy".

Copy wizard 1 starts.

 The color set (CMYK, etc.) and dot type (VD/ND) in the copy will be the same 
as in the original. 

 This function cannot convert a V2 profile into a V3 profile or vice-versa.  
For conversion from a V2 profile to a V3 profile, use the Profile Manager pro-
vided in Raster Link ProIII to RasterLinkPro5.

 The Copy wizard can also be started as follows:
1. Click “Edit” in the [Device Profile] tab.
2. Add the device profile that you want to copy to the edit list. (  P.3-4)
3. Click "Copy".
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2 Select the source device pro-
file.

The source device profile opens.

If there is only one device profilese-
lected in the edit list ( P.3-5) when 
the Copy wizard is started, the path of 
that device profile is already displayed. 
When there is no need for change, pro-
ceed to Step 5.

3 Click  and select the device profile to use as the copy 
source.

4 Select the source device pro-
file and click .

5 Click .
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6 Confirm the source device 
profile condition and click 

.

Set the creation conditions of the desti-
nation device profile.

7 Select a printer and a inkset 
which you want to create a 
device profile and click 

.

8 Set the media name of the 
destination.

You may select from the registered 
media names already registered in 
media name registration procedures.
Set the creation conditions.

9 Click .

10 Set the creation conditions 
of the destination device 
profile.

Selectable combinations of the 
printer, ink set are predeter-
mined.

 The options that are displayed 
are limited by the source 
device profile.
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11 Confirm the device profile 
creation conditions.

Check that the creation conditions 
have been applied.

To change the conditions, click , 
and then change the creation condi-
tions.

12 Click .

Copy wizard 2 is displayed.

13 Set the media character.

( P.2-7)

Set the media character (Feed correc-
tion, Heater temperature, etc.).

The items that can be set here vary 
depending on the printer targeted by 
the destination device profile.

You cannot return to Copy wizard 1 from Copy wizard 2. To change the profile 
conditions after you have moved to Copy wizard 2, you need to redo the proce-
dure from Step 1.

Media character settings are copied if the same setting exists in the source 
device profile and the destination device profile. Furthermore, settings in the 
destination profile that do not exist in the source profile are set to the default 
values.
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14 Set the extended informa-
tion

( P.2-13)

Set the extended information (UV illu-
mination).

15 Click .

16 Save the device profile.

The new device profile is saved.

17 Click .

18 Specify the folder for saving 
the profile, and enter the file 
name to save.

19 Click .

 If the copy source and copy destination printers are the same, the settings will 
be copied.

 If the copy source and copy destination printers are different, the initial values 
will be set.



Chapter 5 Copying a device profile     

5-7

20 Click .

The device profile copy is completed 
and the screen returns to the main 
menu.
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Chapter 6 
Creating the ICC profile 

Procedures for creating a ICC profile are explained.

Flow of creating ICC profile ..................................... 6-2

ICC profile creation ................................................... 6-3
Create an ICC profile of CMYK color ..............................6-3
Create an ICC profile of RGB color ................................6-7
Creates an ICC profile of monitor .................................6-11
ICC profile saving .........................................................6-15
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Flow of creating ICC profile
You can create three types of profiles below with MPM II.

Profile type Details

ICC profile of CMYK color

 Profile to display CMYK color image on the monitor with 
color simulation function. ( P.9-16 )

 Profile to calculate CMYK value when printing specific colors 
using ColorPicker. ( P.8-4 )

 Output Profile for the RIP application compatible with ICC 
Profile made by other companies. 

ICC profile of RGB color

 Profile to display RGB color image on the monitor with color 
simulation function. ( P.9-19 )

 Output profile of the printer for proof using printer driver. 
( P.9-13 )

ICC profile of monitor
 Profile to reproduce colors produced with the printer manu-

factured by Mimaki on the monitor. ( P.9-7 )

 For creating ICC profile of CMYK color and RGB color, only file saving of the 
chart for color measuring is performed. For printing the chart for color measur-
ing, use other application to output with the printer. 

 Creates an ICC profile. 
By measuring colors of the    
chart for RGB color, create    
an ICC profile.

 Creates an ICC profile. 
By measuring colors of the    
chart for CMYK color,   
create an ICC profile.

 Save the chart for 
creating an ICC profile. 

Save the file of the chart     
for RGB color. 

Create an ICC profile of 
CMYK color

 ICC profile saving P.6-15 
Save the created ICC profile.

 Save the chart for 
creating an ICC profile. 

Save the file of the chart     
for CMYK color. 

Creates an ICC profile of 
monitor

Create an ICC profile of 
RGB color

 Creates an ICC profile. 
By measuring colors of the    
monitor following the  
instruction on the screen,   
create an ICC profile.



Chapter 6 Creating the ICC profile

6-3

ICC profile creation
Create an ICC profile of CMYK color

1 Select the [ICC Profile] tab 
and click "Create an ICC pro-
file for CMYK".

2 Click .

3 Select the location for storing 
ICC Profile chart and enter the 
file name.

4 Click .

The confirmation screen is displayed.
Click .
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5 Click .

6 With the target printer, print out the ICC profile chart that has been 
saved.

7 Click  
.

8 Click .
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9 The MeasureTool 5.0 is acti-
vated.

10 Measure the colors on the 
printed chart.

( P.2-29  Step 6)
Select "XX_IccProfileCMYK.txt" for the 
chart name. (XX is the name of the 
color measuring device.)

11 When the measurement is 
completed, click .

12 Specify the "Profile Size" 
and "Perceptual Rendering 
Intent" then click .

 Profile Size
High accuracy :

Create the more accurate ICC 
profile than [Normal] for approx-
imately 3 minutes.  
The file size of the ICC profile is 
about 2MB. 

Normal:
Create the ICC profile in short 
time (approximately 1 minutes). 
The file size of the ICC profile is 
about 700KB. 
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13 Adjust the black replace-
ment.( P.2-72 )

When creating an input profile, adjust-
ing black replacement is not required. 
(There is no problem even if the black 
replacement is adjusted.)

14 Click .

ICC profile creation begins.

15 Click .

16 Click .

 If wrong color measurement file is selected, 
the message shown on the right appears.

Continued on P.6-15"ICC profile saving"
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Create an ICC profile of RGB color

1 Select the [ICC Profile] tab 
and click "Create an ICC pro-
file for RGB".

2 Click .

Depending on the set color measuring 
device, the number of charts to be 
saved differs. 

3 Select the location for storing 
ICC Profile chart and enter the 
file name.

4 Click .

When you wish to save multiple charts, 
select the destination to save the chart 
again and enter the file name.

The confirmation screen is dis-

played.Click .
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5 Click .

6 With the target printer, print out the ICC profile chart that has been 
saved.

7 Click .

8 Click 
.
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9 The MeasureTool 5.0 is acti-
vated.

10 Measure the colors on the 
printed chart.

( P.2-29  Step 6)

11 When the measurement is 
completed, click .

12 Set "Profile size" and "Per-
ceptual Rendering Intent".

 Profile Size
High accuracy :

Create the more accurate ICC 
profile than [Normal] for approx-
imately 2 minutes.  
The file size of the ICC profile is 
about 1.2MB. 

Normal:
Create the ICC profile in short 
time (approximately 1 minutes). 
The file size of the ICC profile is 
about 590KB. 

13 Click .

ICC profile creation begins.
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14 Click .

15 Click .

 If wrong color measurement file is selected, 
the message shown on the right appears.

Continued on P.6-15"ICC profile saving"
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Creates an ICC profile of monitor

1 Select the [ICC Profile] tab 
and click "Create an ICC pro-
file for monitor".

If the measurement device selected is 
not i1 Pro, it cannot be selected.

2 Click .

3 Click .

Measure colors of 
the monitor for sev-
eral minutes. 
Release the screen 
saver or the power 
saving function of 
the monitor. 
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4 The MeasureTool 5.0 is acti-
vated.

5 Click "Device/Port" of the tool 
bar.

"Instrument Configuration" is dis-
played.

6 Check the following items:

 "Eye-One Pro" is selected to 
"Instrument".

 "Emission" is selected.
 "Spectral" is not checked.
 [OK] is displayed below the "Port".

After checking, close "Instrument Configu-
ration".

7 Click "Chart" of the tool bar.

8 Click the downward arrow of 
"Test Chart" to select "Monitor-
Reference.txt".

9 Click .
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10 Place the color measuring device on 
the white reference tile and click 

.

Calibration of the color measuring 
device is performed and the color mea-
suring screen is displayed.

11 Place the sensor part of the 
color measuring device on 
the patch on the monitor.

12 After placing it, click 
.

The measurement is automatically started.

13 From the menu bar, select 
[File] → [Save as...] to save 
the color measurement 
results.

Save the measured result surely mak-
ing "File type" to [Text File (*.txt*.text)].

14 Terminate MeasureTool 5.0.

The file name saved in the Step 13 is 
displayed in the "Measuring color result file".

15 Click .

Place the sensor so 
that there is no gap 
between the sensor 
and the monitor sur-
face.

 If you make color measurement more than once with MeasureTool, 
the last saved file name is displayed. If this is different from the color 
measurement result file you wish to use, click [Select measurement 
file.] to select the file of your choice.
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16 Set "Profile size".

 Profile Size
High accuracy :

Create the more accurate ICC 
profile than [Normal] for approx-
imately 1 minutes.  
The file size of the ICC profile is 
about 680KB. 

Normal:
Create the ICC profile in short 
time (approximately 30 sec-
onds). The file size of the ICC 
profile is about 10KB. 

17 Click .

ICC profile creation begins.

18 Click .

19 Click .

 If wrong color measurement file is selected, 
the message shown on the right appears.

Continued on P.6-15"ICC profile saving"
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ICC profile saving

1 Click .

2 Specify the folder for saving 
the profile, and then enter the 
file name.

3 Click .

4 Click .

Continued from P.6-6  “Create an ICC profile of CMYK color”
Continued from P.6-10  “Create an ICC profile of RGB color”
Continued from P.6-14  “Creates an ICC profile of monitor”
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 "Raster Link series other than Raster Link Pro" indicates the following Ras-
ter Links.

Raster Link UJ Raster Link GP

Raster Link Pro II Raster Link Pro III

Raster Link IP III Raster Link TA III

Raster Link Pro4 SG Raster Link Pro4 IP

Raster Link Pro4 TA Raster Link Pro5 SG

Raster Link Pro5 IP Raster Link Pro5 TA

Raster Link 6

Chapter 7 
Installing and uninstalling profiles

Methods for installing/uninstalling the profiles on the 
Raster Link series are explained.

Install Device Profile in Raster Link Pro ................. 7-2

Installing/uninstalling to/from Raster Link series  
other than Raster Link Pro ....................................... 7-5

Start ProfileManager .......................................................7-5
Install a Profile ................................................................7-7
Uninstall a Profile ..........................................................7-10
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Install Device Profile in Raster Link Pro
Install the created device profile in the Raster Link Pro.

1 Confirm that MPM II is terminated and start Raster Link Pro. 

The spool screen is displayed.

2 Click .

3 Click .

Do not start the Raster Link Pro and MPM II concurrently. This may cause a 
failure. Be sure to exit MPM II first before starting Raster Link Pro. 

 The device profile having the extension of ".icc" can not be installed to Raster 
Link Pro. 

 The Device Profiles installed in Raster Link Pro cannot be uninstalled. 
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4 Click .

5 Select the device profile to be 
installed.

6 Click .
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7 Click .

The screen to confirm the transfer com-
pletion is displayed.

8 Restart the computer.

Device Profile installation is completed.
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Installing/uninstalling to/from Raster Link 
series other than Raster Link Pro
Start ProfileManager

1 Select the [Install] tab and click "Start install".

ProfileManager starts.

MPM II cannot be used during "ProfileManager" is running.
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ProfileManager

Icons

RasterLinkPro5
以前

RasterLink6

Install the Device Profile. ( P.7-7)

Install the Input Profile. ( P.7-7)

Uninstall the Device Profile. ( P.7-10)

Uninstall the Input Profile. ( P.7-10)

Convert V2 profile to V3 profile. 
(This function is absent in RasterLink6 and later.)

This is the screen for RasterLinkPro5 and earlier. 
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Install a Profile

Install the profile in Raster Link series other than Raster Link Pro by using ProfileManager.

1 Select the [Install] tab and 
click "Start install".

ProfileManager starts.

2 To install the Device Profile, click . To install the Input Profile, 

click .

Or, on the [Profile] of the toolbar, click [Install Device Profile] or [Install Input Profile].

The "Browse for Folder" window is displayed.

MPM II cannot be used during "ProfileManager" is running.
 The extension of the profile displayed on "Select install device profile" varies 

between device profiles and input profiles. 
For Device Profile: .cot or .icc files
For Input Profile: .icc or .icm files
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3 Specify the plofile save folder.

4 Click .

The "Select install device profile" win-
dow will be displayed.

5 Select the profile to be installed.

The color of the selected pro-
file is changed to blue.

6 Click .

The selected profiles disappear from the upper list, and they are displayed in the lower 
list.

Saving profiles in one folder 
is recommended, as it is con-
venient that only one time 
installation is required.

 If no relevant profile exists in the specified folder, an error message is dis-
played.

When you wish to select multiple profiles, select them by pressing the Ctrl key.

When the profiles shown on the lower list are to be returned, select the profile 

to return and click .
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7 Click .

The dialog shown on the right is dis-
played.

8 Click .

The added profiles are displayed in the 
ProfileManager list to complete the pro-
file installation.

 If profiles with the same set-
ting exist in the list, a dialog 
to confirm overwriting is dis-
played.

 The installed profiles are displayed in the [Device Profile] tab when Device Pro-
file is installed, and in the [Input Profile] tab when input profile is installed.
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Uninstall a Profile

Uninstall a profile from Raster Link series other than Raster Link Pro.

1 Select the [Install] tab and 
click "Start install".

ProfileManager starts.

2 Select a profile you wish to uninstall from the list in [Device Profile] 
or [Input Profile].

The color of the selected profile is changed to blue.

 The uninstallation method for both the Device Profile and the input profile are 
the same.

When you wish to select multiple profiles, select them by pressing the Ctrl key.
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3 To uninstall the Device Profile, click . To uninstall the Input 

Profile, click .

Or click [Uninstalling Device Profile] or [Uninstalling Input Profile] from [Profile] in the tool-
bar.

The confirmation dialog is displayed.

4 Click .

The dialog on the right appears.

5 Click .

The uninstalled profiles are deleted 
from the ProfileManager list to com-
plete profile uninstallation.
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Chapter 8 
Performing color matching of 

spot color with ColorPicker
The color matching method of the spot color with the color 

exchanging function of ColorPicker and Raster Link series is 
provided here.

Spot color matching with ColorPicker .................... 8-2
What is ColorPicker? ......................................................8-2
Flow of color matching of spot color with ColorPicker ....8-2
Creating the ICC Profile with ColorPicker .......................8-4
Color matching of spot color with ColorPicker ................8-7
Modifying image with Illustrator ......................................8-9
Exchanging the color to output in Raster Link series ....8-11
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Spot color matching with ColorPicker

What is ColorPicker?

ColorPicker is software to measure a color of color sample and calculate its CMYK value for print-
ing the color to reproduce a certain color. 
In case a certain color sample is provided by the client, measure and calculate the CMYK value 
match the color sample with ColorPicker. 

Flow of color matching of spot color with ColorPicker

Provided here is the color matching work of spot color with ColorPicker. 
Using color exchanging function of Raster Link series, it realizes color matching of vector data (CG 
drawn with Adobe Illustrator) for which spot color is specified. 
For the details of the color exchanging function, see the instruction manual of Raster Link series. 

1 Create the ICC Profile with ColorPicker.

 If you want to use ColorPicker in a Macintosh, download it from X-Rite’s web site. 

X-Rite's web site http://www.xrite.com/

Use the color exchanging function of Raster Link Pro II or later of Raster Link 
series. 

Here, flow of the work with i1 Pro as an example is explained. 
Note that i1 iSis cannot be used as a color measurement device for Color-

Picker. 
Precautions for performing color matching of spot color

• A color outside the gamut cannot be reproduced.
• It is assumed that D50 light source is with color matching calculation. There-

fore, the result will not be always the same in your light source environment. 
You are requested to tolerate the difference between what it looks and the 
figures. *1

*1. The displayed color difference value is a predicted value for calculation. Therefore, it provides no              
assurance of the color difference between the actual color output and the color sample.

Work contents
Application to be 

used

Save the color chart for creating the ICC Profile. MPM II

Print the color chart.
Output the color matching in OFF.

Raster Link 
series

Measure the color chart and create the ICC Profile. MPM II
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2 Perform color matching of spot color with ColorPicker.

3 Modify the image with Illustrator.

4 Exchange the color with Raster Link series to output.

Work contents
Application to be 

used

Set up the color matching of ColorPicker.

ColorPicker

Read the created ICC Profile into ColorPicker.

Measure the targeted sample color.

Instruct ColorPicker to make delta E minimum.

Write out the calculation result to the swatch library.

Work contents
Application to be 

used

Read in the swatch library.

Illustrator

Change the color with the swatch library.

Work contents
Application to be 

used

Register the job of the vector image in Raster Link series.

Raster Link 
series

Set up the color exchanging information.

Output the job.
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Creating the ICC Profile with ColorPicker

1 Starting MPM II.

2 Select i1 Pro as the measure-
ment device.

(1) Select the [Setting] tab and click 
"Measurement".

(2) Select i1 Pro.

For selection method of the measure-
ment device, see P.1-6.

3 Select the [ICC Profile] tab 
and click "Create an ICC pro-
file for CMYK".

4 Click .

Depending on the set color measuring 
device, the number of charts to be 
saved differs. 

5 Save the chart for an ICC profile. 



Chapter 8 Performing color matching of spot color with ColorPicker         

8-5

6 Starting Rastser Link series.

7 Add the stored chart to Ras-
ter Link series as a job.

(1) Select [Open] from [File].
(2) Add the chart stored in the Step 

3-(3).

8 Open the job editor of the 
created job.

Turn off the check box for "Valid" in the 
[Color Matching] tag in the [Color Edit] 
tag.

Output the chart after performing set-
ting.
For the output method in Raster Link 
series, see the Operation Manual of 
Raster Link series.

9 Measure the color of the chart output in the Step 7 and create the 
ICC Profile.

(1) Select the [ICC Profile] tab and 
click "Create an ICC profile for 
CMYK".

(2) Click .
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(3) Click .

(4) Click  
to measure the chart.For the 
measurement method, see P.2-
34.

(5) When the measurement is com-

pleted, click .
(6) Perform basic setting of the Pro-

file and the black printer.For set-
ting method, see P.6-5.

Leave the black printer setting 
default.For the details of setting con-
tents, see P.2-72.
Select "XX_IccProfileCMYK.txt" for the 
chart name. (XX is the name of the 
color measuring device.)

10 Click .

After creating the ICC Profile, click .

11 Save the created ICC Profile and terminate MPM II.

Continued on P.8-7"Color matching of spot color 
with ColorPicker"
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Color matching of spot color with ColorPicker

1 Connect i1 Pro (measurement 
device) to PC and start up Color-
Picker.

2 Select [Preferences...] from [Edit] and 
perform setting as below. Then click 

.

Instrument Port : AUTO
Distance Formula : ΔE2000
CMM : LogoSync
Rendering Intent : Absolute

3 Click the list box of [Instrument] and 
select "Eye-One Pro".

4 Click .

 If i1 Pro is not recognized, 
change the connection point of 
the USB cable or try to install the 
driver again.
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5 Click  and select the ICC Pro-
file created in “Creating the ICC Pro-
file with ColorPicker”.

6 Measure the color sample with i1 Pro.

Place the lens part of i1 Pro on the color sample 
and press the button on the side face of i1 Pro. 

When the beep sound is heard the measured 
color will be displayed in ColorPicker. 

7 Adjust the measured data.

(1) Check if the "Maximum Number 
Of Channels" box is checked and 
the value is set to "4". Check if 
the "Minimum Ink Coverage" box 
is checked and the value is set to 
"2.0". 

(2) Click .The value of 
color difference of "Edited Device 
Color" will become smaller and it 
can be edited to more proper 
color. 

(3) Input the name of the measured 

color and click .

8 After measuring the required color samples, select [Export Device 
Colors...] from [File].

 " ! " mark is displayed for the item of the color difference 5 and more. If " ! " 
mark is not cleared by clicking  button, it indicates that the color 
is outside the Gamut (not to be reproduced).
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9 Click  button with its 
extension being ".ai" to save it 
as Illustrator swatch library.

Modifying image with Illustrator

1 Terminate ColorPicker and start up Illustrator.

2 Open the image to be output.

3 From [Window], select [Swatch Libraries] and then [Other Library]. 
Read the ".ai" file stored in the Step 9 of “Color matching of spot 
color with ColorPicker”.

 If you set a folder in Illustrator as the location for storing directly, setting in Illustra-
tor will become easier.  
C:\Program Files\Adobe\Illustrator(Version)\Presets\Swatches

 If you set a folder in Illustrator as the location for storing in the Step 8 of “Color                 
matching of spot color with ColorPicker”, only selecting [Swatch Libraries] from          
[Window] will list up the created swatch library.

Continued on P.8-9"Modifying image with Illustrator"
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4 Set up the color read in the Step 3 to the spot color.

(1) Add the read color to the swatch library.

(2) Double-click the color added in the swatch 
library and set up the spot color.

5 Using the color added to the 
swatch library, modify the 
image.

6 Store the image as EPS, terminate the Illustrator.

Continued on P.8-11"Exchanging the color to 
output in Raster Link series"
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Exchanging the color to output in Raster Link series

1 Starting Rastser Link series.

2 Register the job of the vector 
image in Raster Link series.

For the job registration method, see the 
Operation Manual of Raster Link 
series.

3 Open the job editor, and select 
the [Color Replacement] tab.

Select the [Color Replacement] tab from the [Color Edit] tab.

4 Select the [Color Replacement] tab and add the color exchanging 
information.

(1) Input the name of color exchang-

ing and click .
(2) Specify the color to be 

exchanged.
･ If the spot color name is specified, 

click the listed spot color name.
･ If the spot color name is not 

specified, click the color on the 
preview image.

(3) Input the CMYK value displayed 
in [Input] to [Output].

(4) Click  and add the color 
exchanging information.

(5) After performing setting, click 

 to terminate the job editor.

5 Output in Raster Link series.
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Chapter 9 
　Perform color simulation  

The procedures to reproduce (simulate) colors printed with a        
printer manufactured by Mimaki using a monitor or a printer for          

proof (consumer printer) are explained.    

Perform color simulation using Adobe  
Photoshop/ Illustrator .............................................. 9-2

Note on color simulation function ....................................9-2
System environment required for color simulation  
function ...........................................................................9-3
Preparation to use color simulation function ...................9-3
Flow of color simulation ..................................................9-4
Use high-color rendering fluorescent to arrange  
environment light (option) ...............................................9-6
Perform calibration of the monitor ...................................9-6
Creates an ICC profile of the monitor .............................9-7
Create an ICC profile of the printer for proof ................9-13
Create the profile for CMYK color simulation ................9-16
Create the profile for RGB color simulation ..................9-19
Set the created profile in Photoshop/Illustrator .............9-22
Adjust colors so that colors on the monitor can be  
similar to the target colors .............................................9-25
Output with the printer for proof to check color difference  
between it and the target ..............................................9-28
Print with the printer for proof .......................................9-32
Output with the printer manufactured by Mimaki ..........9-32
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Perform color simulation using Adobe  
Photoshop/ Illustrator
By performing color simulation, you can reproduce (simulate) colors produced with the printer 
manufactured by Mimaki on the monitor or the printer for proof.

Note on color simulation function

Merit of using color simulation function
 It can eliminate the need for color adjustment in each time, comparing the color 

produced   with the printer manufactured by Mimaki to the target color. You can 
reduce useless work and improve the working efficiency. 

As the color produced with the printer manufactured by Mimaki is displayed on 
the monitor, the accuracy of the color adjustment on the monitor can be 
improved. 

You can use the result printed with the printer for proof (consumer printer) as 
the color sample for your client. 

Even if you use this function, the color does not always match the one pro-
duced with the printer manufactured by Mimaki. (This is because you cannot 
fully simulate the color produced with the printer manufactured by Mimaki, as 
each printer or monitor has characteristic difference or individual difference.)

 The color outside the gamut of the monitor or the printer for proof cannot be 
reproduced. 

 To perform color simulation with the monitor or the printer for proof, it is 
required to create an ICC profile for simulating the color produced with the 
printer manufactured by Mimaki.

 The color of the printed material changes in appearance depending on your 
environment light source. It is supposed that D50 light source is to be used for 
this function.



Chapter 9 　Perform color simulation    

9-3

System environment required for color simulation function

It is necessary to prepare environment below to use the color simulation function.

Preparation to use color simulation function

To use the color simulation function, install software below:

Mimaki Profile MasterII v2.00 Use to create an ICC profile.

Raster Link series Outputs the required chart when creating an ICC profile.

i1 Pro Use to measure colors of the monitor.

Adobe Photoshop
Adobe Illustrator

Use to adjust the color of the image or to display simulation           
on the monitor.
Use Photoshop 6.0 and later/Illustrator 9.0 and later       
supporting color management. (CS and higher is      
recommended.)

Operator PC
PC on which Adobe Photoshop/Illustrator has been      
installed.

Monitor supporting color 
management

Monitor of the operator PC.
The one supporting AdobeRGB or sRGB. (The one with        
hardware calibration function is recommended.)

High color rendering fluorescent *1

*1. Prepare this optionally.

Fluorescent with color temperature of 5000K for color       
appraisal.
Use as the observation light source of the printed material.

Printer for proof
Consumer printer commercially available. (To output     
correctly, the one for professional use is recommended.)

Raster Link series *1

*1. For installation procedures, refer to the installation guide of Raster Link series.

MPMII

i1 Pro driver *2

*2. The driver is included in the CD of MPMII. 
Specify the folder below in the CD of MPMII when specifying the driver. 
[CD drive]Driver\EyeOne

Adobe Photoshop、AdobeIllustrator *3

*3. For installation procedures, refer to the user's manual of each software.

Software used for calibration of monitor *3 Printer driver of printer for proof *4

*4. For installation procedures, refer to the user's manual of consumer printer to use.

 If the PC to use for adjusting image file requested by the client (operator PC) 
differs from the PC to output to the printer manufactured by Mimaki (PC for out-
putting), install the following items referring to the table below:

Raster Link series PC for outputting

MPMII PC for outputting, Operator PC *1

*1. Only when Windows is used for operator PC.

X-Rite i1 Pro driver Operator PC, PC for outputting

Printer driver of printer for proof Operator PC

Software for calibration of monitor Operator PC

Adobe Photoshop、Adobe Illustrator Operator PC



9-4

Flow of color simulation

1 Prepare to perform color simulation.

Prepare to simulate colors output with the printer manufactured by Mimaki with the moni-
tor or the printer for proof.

Work contents
Application to be 

used

Install high-color rendering fluorescent to arrange     
environment light. (option) P 9-6 

Perform calibration of the monitor to adjust aging. P 9-6 Monitor

Creates an ICC profile of monitor. P 9-7 MPM II

Output the chart with the printer for proof to create an ICC           
profile for the printer for proof. P 9-13 

Photoshop
Illustrator
MPM II

Output the chart for CMYK with the printer manufactured by         
Mimaki to create the profile for CMYK simulation.  

P 9-16 
MPM II

Raster Link 
series

Output the chart for RGB with the printer manufactured by         
Mimaki to create the profile for RGB simulation. P 9-19 

Set each profile for simulation in software. P 9-22 
Photoshop
Illustrator
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2 Edit the image with Photoshop/Illustrator.

You can simulate colors produced with the printer manufactured by Mimaki on the moni-
tor. In addition, you can output with the printer for proof and simulate the edited result. 

3 Output with the printer for proof.

4 Output the image with the printer manufactured by Mimaki.

 For Raster Link series, you can perform different rendering intent 
(color conversion) for raster data and vector data separately. However, 
you can simulate only one type of color conversion on the monitor.

 It is recommended to check raster data with Photoshop and to check 
vector data with Illustrator. In addition, to make each setting same as 
in Raster Link series is recommended. 

Work contents
Application to be 

used

Adjust colors so that those of the monitor can become         
similar to the target colors. P 9-25 

Photoshop
Illustrator

Output with the printer for proof to check difference        
between it and the target color. P 9-28 

Work contents
Application to be 

used

You can use calibration paper output with the printer for         
proof as the color sample. P 9-32 

Photoshop
Illustrator

Work contents
Application to be 

used

Output with the printer manufactured by Mimaki and make        
the client check finally. P 9-32 

Raster Link 
series
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Use high-color rendering fluorescent to arrange environment light       
(option)

Change environment light of the place to be 
used for color matching.

Perform calibration of the monitor

Using software for calibration attached to the monitor, perform hardware calibration.  Operate by 
following instruction of software to use. 

Changing environment light is only as a recommended procedure. It is not 
required when you can always prepare a fixed environment or if environment 
light differs much from the presented place of the printed material. 

 It is supposed that D50 light source is to be used. Depending on your environ-
ment, colors output with the printer manufactured by Mimaki do not match col-
ors simulated with the printer for proof in some cases.

Calibration to adjust the monitor display environment is required to demon-
strate the performance of the monitor. 

 The colors displayed on the monitor will change while it is used for a long time. 
If this color change will be left as it is, the simulation accuracy with the monitor 
will be degraded. To correct this color change, periodical calibration of the mon-
itor is recommended. 

Target of environment light

Color temperature 5000K

Illuminance 600lx
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Creates an ICC profile of the monitor

If an ICC profile has already been prepared by the monitor manufacturer, use the prepared ICC 
profile. 

Set in the profile of the monitor you use (for Windows Vista)

1 Install the created ICC profile in the PC.

2 Click [Start] → [Control 
Panel].

3 Open "Color Management".

 If you create an ICC profile of the monitor using MPMII, refer to the P.6-11"Cre-              
ates an ICC profile of monitor". Set the created ICC profile in the profile of the               
monitor you use.
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4 Set as below and click .

Device: "Display: ------"
Check the box of "Use my settings for 
this device."

5 Select the created ICC profile 
and click .

6 Set the added profile to the default profile.



Chapter 9 　Perform color simulation    

9-9

Set to the profile of your monitor (for Windows XP)

1 Click  
[Start] → [Control Panel].

2 Open "Display".

3 Select "Setting" tab and click 
.
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4 Select the "Color Manage-
ment" tab and click .

5 Select the created Profile and 
click .

6 Select the added profile and 
click .
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Create an ICC profile of the Macintosh monitor (for Mac OSX version 10.6)

1 Download ProfileMaker from the Web site of X-Rite, Incorporated 
(http://www.erite.com/) and install it.

If MeasureTool has already been installed, this step is not required.

2 Start Measure Tool of Profile-
Maker.

3 Measure colors with Measure 
Tool of ProfileMaker and save the measured result.

For the test chart when measuring colors, select "LCD Monitor Reference 2.0.txt".

4 Copy the color measuring file to the PC on which MPMII has been 
installed.

5 Starting MPM II.

6 Creates an ICC profile of mon-
itor. 

Create by referring to the P.6-11"Cre-     
ates an ICC profile of monitor".
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7 Following procedures below, install the created ICC profile of the 
monitor into your Macintosh.

(1)For Mac OS 8.X or 9.X, copy the ICC profile in the ColorSync Profile folder in the system                 
folder.

(2)For Mac OS X, copy the ICC profile in -User/ your log-in user name/ Library/              
ColorSync/ Profiles or -Library/ ColorSync/ Profiles/ Display. 
･ However, the license for administrator is required for installing the ICC profile here. 

8 Click [Displays] of “System 
Preferences”.

9 Select [Color] tab and the ICC 
profile of the monitor created 
from the display profile list.

10 Click .

Apple Display Calibrator Assistant will 
start. As it is supposed that D50 light 
source is used for printing material, set 
the white point to use to D50. 
For the procedures, refer to the system 
environment setting of Mac help. 
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Create an ICC profile of the printer for proof

Output the chart with the printer for proof and create the ICC profile of the printer for proof. 
(The procedures when Adobe Photoshop CS is used are explained as an example.)

1 Starting MPM II.

2 Save the chart to create the RGB printer profile.

Refer to P.6-7"Create an ICC profile of RGB color"steps 1 to 5.

3 Connect the printer for proof to use with the PC.

4 Start Adobe Photoshop.

5 Open the saved chart file without color management.

If you saved multiple charts, be sure to open all charts.

6 Click [File] → [Print with PreView].

7 Check the box of [Show More 
Options].

8 Make the setting of the color 
management like below:

Select [Document] to "Souce Space".
Select "Same As Souce" to the profile 
of "Print Space".

9 Click .

Use the ICC profile created here for outputting from Adobe Photoshop/Illustra-
tor to the printer for proof. Install the created ICC profile in the PC on which 
Adobe Photoshop/Illustrator has been installed.
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10 In the "Name", select the 
printer for proof to use and 
click .

The selected printer setting screen is 
displayed.

11 Set the color management 
option of the printer driver off.

For the setting items for color management or color adjustment of printer driver setting, 
set color management off or without color adjustment. For setting procedures, refer to the 
user's manual of the printer to use.

12 Click .

The chart will be printed. 
When there are multiple files, print all in 
the same setting. 

13 Start MPMII and perform color measuring to create an ICC profile 
of RGB color. 

Refer to P.6-7"Create an ICC profile of RGB color" steps 7 to 15.

 If you do not set color management of the printer driver off, colors to 
be simulated with the printer for proof do not match.
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14 Click the right mouse button 
on the created ICC profile to 
display the short cut menu.

15 Click [Install Profile].

When you use Macintosh for the operator PC, install the ICC profile by fol-
lowing the procedures below: 
 For Mac OS 8.X or 9.X, copy the ICC profile in the ColorSync Profile folder in 

the system folder.
 For Mac OS X, copy the ICC profile in -User/ your log-in user name/ Library/ 

ColorSync/ Profiles or -Library/ ColorSync/ Profiles. 
However, the license for administrator is required for installing the ICC profile 
here. 
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Create the profile for CMYK color simulation

Create an ICC profile to print the chart for CMYK with the printer manufactured by Mimaki and to 
simulate colors of CMYK image with the monitor or the printer for proof.

1 Starting MPM II.

2 Save the chart to create the CMYK printer profile.

Refer to P.6-3"Create an ICC profile of CMYK color" steps 1 to 5.

3 Starting Raster Link series.

4 Select [Open] from [File].

5 Select the saved chart.

6 Click the right mouse button 
with the chart selected and 
click [Edit].

"Job Editor" screen will open.

 Install the created ICC profile in the PC on which Adobe Photoshop/Illustrator 
has been installed.
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7 Perform setting to output the chart.

With job editor, you can perform setting for "image edit", "print condition" and "color edit".

Image Edit : It is not necessary to copy etc. normally. However, when you wish to 
transfer printing (mirror setting etc.), set if it is required. ? 
Check whether the chart to output is within the valid drawing area on 
the preview screen. 

Print Condition : Set the same printing condition as when you usually print with the 
printer manufactured by Mimaki. 

Color Edit : Perform the same setting as when you usually print with the printer 
manufactured by Mimaki. 

Check that "Valid" is not checked in [Scale] of the 
image edit tab. If you use the enlarged/reduced chart 
with "Valid" is checked, you cannot create proper pro-
file when it is created in the Step 9. 

 The chart saved in the Step 2 is the raster data. In the 
[Color matching] of the color edit tab, set "Image".

If the setting of "Illustration" differs from "Image" when 
you usually output with the printer manufactured by 
Mimaki
 For example, you output with [ICC] and [Perceptual] for 

"Image" and [Gray balance] for "Illustration", separate ICC 
profile is required for each to simulate both conditions.  
You can simulate output of "Image (raster data)" for the 
ICC profile created by using the chart output with the set-
ting of [ICC] and [Perceptual].  
In addition, you can simulate output of "Illustration (vector 
data)" for the ICC profile created by using the chart output 
with the setting of [Gray balance].
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8 When the setting is completed, output the chart.

After printing the chart, terminate Raster Link series.

9 Create the ICC profile of CMYK color with MPMII using the printed 
chart.

Refer to P.6-3"Create an ICC profile of CMYK color" steps 7 to 16.

10 Click the right mouse button 
on the created ICC profile to 
display the short cut menu.

11 Click [Install profile].

When you use Macintosh for the operator PC, install the ICC profile by fol-
lowing the procedures below: 
 For Mac OS 8.X or 9.X, copy the ICC profile in the ColorSync Profile folder in 

the system folder.
 For Mac OS X, copy the ICC profile in -User/ your log-in user name/ Library/ 

ColorSync/ Profiles or -Library/ ColorSync/ Profiles. 
However, the license for administrator is required for installing the ICC profile 
here. 
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Create the profile for RGB color simulation

Create an ICC profile to print the chart for RGB with the printer manufactured by Mimaki and to 
simulate colors of RGB image with the monitor or the printer for proof.

1 Starting MPM II.

2 Save the chart to create the ICC profile of RGB color.

Refer to P.6-7"Create an ICC profile of RGB color" steps 1 to 5.

3 Starting Raster Link series.

4 Select [Open] from [File].

5 Select the saved chart.

If you saved multiple charts, be sure to 
open all charts.

6 Click the right mouse button 
with the chart selected and 
click [Edit].

"Job Editor" screen will open.

 Install the created ICC profile in the PC on which Adobe Photoshop/Illustrator 
has been installed.
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7 Perform setting to output the chart.

With job editor, you can perform setting for "image edit", "print condition" and "color edit".

Image Edit : It is not necessary to copy etc. normally. However, when you wish to 
transfer printing (mirror setting etc.), set if it is required.  
Check whether the chart to output is within the valid drawing area on 
the preview screen. 

Print Condition : Set the same printing condition as when you usually print with the 
printer manufactured by Mimaki. 

Color Edit : Perform the same setting as when you usually print with the printer 
manufactured by Mimaki. 

Check that "Valid" is not checked in [Scale] of the 
image edit tab. If you use the enlarged/reduced chart 
with "Valid" is checked, you cannot create proper pro-
file when it is created in the Step 9. 

 The chart saved in the Step 2 is the raster data. In the 
[Color matching] of the color edit tab, set "Image".

If the setting of "Illustration" differs from "Image" when 
you usually output with the printer manufactured by 
Mimaki
 For example, you output with [ICC] and [Perceptual] for 

"Image" and [Gray balance] for "Illustration", separate ICC 
profile is required for each to simulate both conditions.  
You can simulate output of "Image (raster data)" for the 
ICC profile created by using the chart output with the set-
ting of [ICC] and [Perceptual].  
In addition, you can simulate output of "Illustration (vector 
data)" for the ICC profile created by using the chart output 
with the setting of [Gray balance].
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8 When the setting is completed, output the chart.

After printing the chart, terminate Raster Link series.

9 Create the ICC profile of RGB color with MPMII using the printed 
chart.

Refer to P.6-7"Create an ICC profile of RGB color" steps 7 to 15.

10 Click the right mouse button 
on the created ICC profile to 
display the short cut menu.

11 Click [Install profile].

When you use Macintosh for the operator PC, install the ICC profile by fol-
lowing the procedures below: 
 For Mac OS 8.X or 9.X, copy the ICC profile in the ColorSync Profile folder in 

the system folder.
 For Mac OS X, copy the ICC profile in -User/ your log-in user name/ Library/ 

ColorSync/ Profiles or -Library/ ColorSync/ Profiles. 
However, the license for administrator is required for installing the ICC profile 
here. 
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Set the created profile in Photoshop/Illustrator

When setting in Photoshop

The procedures when the profile is set in Photoshop are explained. (example of Photoshop CS)

1 Starting Photoshop.

2 Click [Edit] → [Color settings].

Set the created profile in Photoshop/illustrator before you edit the image.
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3 Click "Advanced Mode".

4 Set each item as below and 
click .

Working 
Spaces

RGB
Select the created ICC   
profile of RGB color.

CMYK
Select the created ICC   
profile of CMYK color.

Color 
Management 
Policies

RGB OFF

CMYK OFF

Check the box of [Profile    
Mismatches:Ask when Opening].

Conversion 
Options

Engines Adobe(ACE)

Intent Perceptual

･ Check the box of [Use Black     
Point Compensation].

･ Check the box of [Use    
Dither].
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When setting in Illustrator

The procedures when the profile is set in Illustrator are explained. (example of Illustrator CS2)

1 Starting Illustrator.

2 Click [Edit] → [Color settings].

3 Click "Advanced Mode".

4 Set each item as below and 
click .

Working 
Spaces

RGB
Select the created ICC   
profile of RGB color.

CMYK
Select the created ICC   
profile of CMYK color.

Color 
Management 
Policies

RGB OFF

CMYK OFF

Check the box of [Profile    
Mismatches:Ask when Opening].

Conversion 
Options

Engines Adobe(ACE)

Intent Perceptual

･ Check the box of [Use Black 
Point Compensation].
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Adjust colors so that colors on the monitor can be similar to the            
target colors

Simulate and display colors output with the printer manufactured by Mimaki on the monitor.

Adjusting procedures when opening image in Photoshop

The procedures when you open the image file to edit in Photoshop are explained. (example of 
Photoshop CS)

1 Starting Photoshop.

2 Select the image file from [File] → [Open].

3 When you open the file, mes-
sage window is displayed.

4 Select "Discard the embedded 
profile (don't color manage)".

5 Click .

The image is displayed.

6 Click [View] → [Proof Setup] 
→ [Custom].
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7 Set the calibration condition 
as below and click .

･ Profile： 
ICC profile set for the monitor     
profile

･ Do not check the box of [Preserve      
Color Mumbers].

･ Intent：Perceptual
･ Check the box of [Use Black Point      

Compensation].
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Adjusting procedures when opening image in Illustrator

The procedures when you open the image file to edit in Illustrator are explained. (example of Illus-
trator CS2)

1 Starting Illustrator.

2 Select the image file from [File] → [Open].

3 When you open the file, mes-
sage window is displayed.

4 Select "Discard the embedded 
profile (don't color manage)".

5 Click .

The image is displayed.

6 Click [View] → [Proof Setup] 
→ [Custom].

7 Set the calibration condition 
as below and click .

･ Device to Simulate： 
ICC profile set for the monitor     
profile

･ Do not check the box of [Preserve      
Color Mumbers].

･ Intent：Perceptual

 If colors output with the printer manufactured by Mimaki do not match 
colors on the monitor easily, it is required to create the profile for simu-
lation again.
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Output with the printer for proof to check color difference between it           
and the target

Simulate colors output with the printer manufactured by Mimaki and output them on the paper. 

When outputting in Photoshop

The procedures when you output to the printer for proof in Photoshop are explained. (example of 
Photoshop CS)

1 Starting Photoshop.

2 Select the image file to print from [File] → [Open].

3 Click [File] → [Print with PreView].

4 Check the box of "Show More 
Options".

5 Set the color management as 
below and click .

6 Select the printer for proof for 
"Printer name" and click 

.

The selected printer setting screen is 
displayed.

Souce Space Check [Document].

Souce Space

Profile
Select the created ICC 
profile of the printer for 
proof.

Intent
Keep absolute color 
range.



Chapter 9 　Perform color simulation    

9-29

7 Set the color management option of the printer driver off.

For the setting items for color management or color adjustment of printer driver setting, 
set color management off or without color adjustment. For setting procedures, refer to the 
user's manual of the printer to use.

8 Click .

The image is output.

 If you do not set color management of the printer driver off, colors to 
be simulated with the printer for proof do not match.
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When outputting in Illustrator

The procedures when you output to the printer for proof in Illustrator are explained. (example of 
Illustrator CS2)

1 Starting Illustrator.

2 Select the image file to print from [File] → [Open].

3 Click [File] → [Print].

4 Click . 

5 Select the printer for proof to 
use from "Select Printer" and 
click .

The selected printer setting screen is 
displayed.
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6 Set the color management option of the printer driver off.

For the setting items for color management or color adjustment of printer driver setting, 
set color management off or without color adjustment. For setting procedures, refer to the 
user's manual of the printer to use.

7 Click .

8 Set the "Print Method" of 
"color management" as 
below.

9 Click .

The image is output.

 If you do not set color management of the printer driver off, colors to 
be simulated with the printer for proof do not match.

Color 
Handring

Let Illustrator determine colors

Profile
Select the created ICC profile of the      
printer for proof.

Rendering 
Intent

Keep absolute color range.

 If colors output with the printer manufactured by Mimaki do not match colors on 
the monitor easily, it is required to create the profile for simulation again.
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Print with the printer for proof

Output the image file on which color adjustment has been performed with Photoshop/Illustrator to 
the printer for proof.
You can use the output paper as color sample.

Output with the printer manufactured by Mimaki

Output with the printer manufactured by Mimaki and make the client check finally. 
Output the image file on which color adjustment has been performed with Raster Link series to the 
printer manufactured by Mimaki.
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Create the Metallic Color Profile

Target Environment

A Metallic Color Profile can be created in the following environment.

Creation Condition

Only a Metallic Color Profile based on the following conditions can be created.

What is a Metallic Color Profile?

A profile specially designed to enhance the brightness of metallic tones in printed areas where 
color ink is applied over silver ink is called a "Metallic Color Profile".

1. Use with RasterLink6

With RasterLink6, you can set a Metallic Color Profile for silver and a color applied over it.

Example:  To print metallic color circles over a blue square:

The method for setting the profiles is explained in “Print checking with RasterLink6” from P 10-16 .

Printer CJV300 / CJV150

Ink SS21

Color It require to mount Silver ink on the printer.

RIP RasterLink6 Ver3.0 or later

Printer Ink set Resolution Pass

CJV300 8Color
CJV150 8Color

SS21 CMYKLcLm
SS21 CMYKLkOr

720x1080 VD 12 passes or more

720x1440 VD 20 passes or more

1440x1440VD 32 passes or more

Use a Metallic Color Profile for 
these

Use a regular profile for this



Chapter 10 Create the Metallic Color Profile

10-3

1.1 Relationship with Full Color Profile

Metallic Color is usually used simultaneously with Color. The creation conditions with 
MPMII (resolution, number of passes, heater temperature) will vary depending on 
whether quality for the Color or the Metallic Color is prioritized.

Using Metallic Color for accent

In most cases, Metallic Color is used in an accentual way, and its print area is small com-
pared to the Color. In such cases, it is best to prioritize the image quality of the Color, so you 
should make the creation conditions for the Metallic Color match the profile for the Color used 
simultaneously with it.

Using Metallic Color as main color

In cases where the print area of the Metallic Color is large compared to the Color and you 
want the image quality for the Metallic Color to be as good as possible, create it using the rec-
ommended conditions given on P.10-7.

2. Output of metallic color in MPMII

In print in Mimaki Profile Master II, it is compatible with the Silver or Silver  color output.

3. Hint for Metallic color

In regard to the color tone of Metallic color, please refer to the SS21 Metallic Color Library 
chart which is output using Metallic color profile released by Mimaki.
The outputting of SS21 Metallic Color Library chart is available on Metallic Color Print Guideh 
of RasterLink6.
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Before Creating a Metallic Color Profile

1. Printer settings

Set the printer as follows:

1 Turn the power of the printer main unit ON.

Make sure that "Local" is displayed on the panel.

2 Set Logical Seek to OFF.

(1) Press "MENU" ([FUNC1] key).
(2) Press the [ENTER] key.
(3) Press the [ ▼ ] key a few times and select "LOGICAL SEEK".
(4) Press the [ENTER] key.
(5) Press the [ ▼ ] key a few times and select "OFF".
(6) Press the [ENTER] key.

3 Set Drying Time to 0.0 second.

(1) Press the [ ▼ ] key a few times and select "DRYING TIME".
(2) Press the [ENTER] key.
(3) Press the [ ▼ ] key a few times and select [SCAN].
(4) Press the [ENTER] key.
(5) Press [ ▲ ][ ▼ ] and set Drying Time to "0.0s".
(6) Press the [ENTER] key.

4 Press the [END] key a few times so that "Local" is displayed on the 
panel.

Please make sure that whether the media which is created the profile is 
firmly set by the printer, and perform “Media Correction” after completing the 
above-mentioned setting. Regarding the “Media Correction”, please refer to 
the operation manual of the printer. 
If feed correction has not been set appropriately, the image quality at the por-
tion where Silver Ink is used could be poor.
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2. Registering a media name for Metallic Color Profile

To distinguish a Metallic Color Profile from a regular device profile, only a media name with 
"Si" added to the end can be used for Metallic Color Profile.
To add a media name for Metallic Color Profile:

1 In the main window, select the 
[Setting] tab and click [Media 
name].

2 The [Media registration] window appears.

From the list displayed, select a media name for creating a Metallic Color Profile.

3 In the menu, select [Option]–[Reg-
ister media name for Metallic 
color profile].

4 A message appears, asking you 
to confirm that you are going to 
register the media name for Metal-
lic Color Profile.

Press [Yes] for registration.

5 Use [Close] to close the [Media registration] window.

 If you do not find any media name you want to register in the list, register a new 
media name. For details on how to register a media name, see P.1-3 “Registra-             
tion of a media name”.

A media name for Metallic Color Profile is dis-
played in color in the list.

 In the regular media name registration procedure, 
a media name cannot be registered with "Si" 
added to the end. This is because a Metallic Color 
Profile is to be used with a regular device profile 
simultaneously.
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Creating a Metallic Color Profile

1. Procedure for creating a Metallic Color Profile

Follow the procedure below to create a Metallic Color Profile.

1. Run the Metallic Color Profile creation wizard.

2. Set the creation conditions.

3. Media-specific information settings: set the heater temperature.

4. Special color information settings: set the silver density.

5. Check the variable dot setting for the color.

6. Whole color ink limit settings:
(1) Implement chart output, to print out a chart of the CMYK single colors.
(2) Visually check the chart, and set the densities.

7. Check the Light Ink settings for the colors.

8. Set the ink limit for the tertiary colors.
(1) Implement chart output, to print out a 3-color chromatic chart.
(2) Visually check the chart, and set the densities.

9. Save the profile.

Install the Metallic Color Profile to RasterLink6, and run a print check.
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2. Metallic Color Profile creation wizard startup

In the main window, select [Device Profile] and 
click [Create Metallic Color Profile].

3. Creation condition setting

3.1 Setting the print conditions

Metallic Color is usually used simultaneously with Color. The creation conditions with 
MPMII (resolution, number of passes, heater temperature) will vary depending on 
whether quality for the Color or the Metallic Color is prioritized.

The Metallic Color Profile creation wizard starts.
Select the desired conditions for creation and 
press [Next].

3.2 Media selection

Select the media name and press [Next].

 If no media for Metallic Color Profile 
are registered, this wizard does not 
start even if you click [Create Metallic 
Color Profile]. In this case, add media 
by referring to 1 Preparation - Register-
ing a media name for Metallic Color 
Profile.

Recommended creation conditions
 The recommended conditions for the    

desired quality are as in the table      
below. 
However, if there are Full Color Profile      
conditions that are to be used     
simultaneously, you should apply them    
instead according to P.10-3.

Only a media name for Metallic Color 
Profile (with “Si” added to the end) can 
be selected.

Quality Resolution pass
Print 

direction
Hi-speed 

print

Standard 720x1080VD 16 Bidirectional ON

High 720x1440VD 32 Bidirectional ON
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3.3 Creation condition checking

Check the set conditions, and if they are OK, 
press [Next].

4. Media character setting

Set Heater temperature, Feed correction, Feed 
setting and press [Next].

About heater temperature
Be sure to enable heater temperature.
 The recommended values for heater temperature are the following: 

CJV300: Pre 50°C / Print 45°C / Post 60°C 
CJV150: Pre 50°C / Print 45°C / Post 50°C

With RasterLink6, if a job that a Full Color Profile has been set for is compos-
ited with a job that a Metallic Color Profile has been set for and you set “Profile 
Setting” for [Device Adjustment], a heater temperature for the Metallic Color 
Profile will be set.
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5. Special color information setting - Setting Silver Density

Special color information refers to information used for setting silver and white appropriately.
A regular (color) device profile for JV300/150 and CJV300/150 each automatically sets preset 
information; a Metallic Color Profile can change only the silver density in the above informa-
tion.
By changing the silver density, you can adjust the print quality of silver monochrome.

5.1 Chart outputting

Perform a Test Print to adjust the density of silver.

1 Check that the density of silver is 
[100%].

2 Press [Test Print].

3 The Open dialog box appears.

Select the following file:
MPMII installation folder¥Image¥SilverInkLimitTestChart.tif

4 The [Image Edit] window appears.

Check that “Replace BLACK” is set for 
[Silver ink]–[Print method], and press 
the [Output] button for printing.

 For Test Print in [Special color information setting], an image is output after 
Mono color replacement based on Silver ink.

A metallic color is usually out-
putted as a Special Color 
Over Print in the form of Silver 
 Color. Therefore, here you 
should print silver as a single 
color, using the same print 
method as for Special Color 
Over Print.

1
2
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5.2 Assessing the chart printed out

The chart below will be printed. Use the hints set out below to determine the density.

Finding a mirror-surface glossiness

Select a patch that reflects light like a mirror and gives a glossy feel.
[How to find mirror-like quality]
Place some printed matter or similar at right angles to the chart, and 
observe the degree of reflected glare.

Check the image quality

Check for bleeding, faintness or banding, and choose a patch where none of these occurs.

Bleeding : Ink spills over at the patch’s edge, giving a whitish look.
Faintness : Roughness occurs, as if the surface had been scraped.
Banding : Bands occur in the scan direction.

Examples of poor image quality

Bleeding Faintness Banding

Check the wind-up performance

Due to its properties, Silver Ink has poorer abrasiveness and wind-up performance 
than Color Ink. And the higher Silver Ink’s density, the poorer its performance is. If you 
often use wind-up, check the performance using the following procedure.

(1) Wind up the chart you printed out.
(2) Leave it for 12 to 24 hours or so.
(3) Take out the wound-up chart and visually check its condition. 

A patch whose density is such that blocking occurs in it due to offset cannot be 
used.

If there is no usable patch:
 If you find no usable patch when you assess the chart, go back to the [Media 

Character setting] page, raise the temperatures of the pre-heater, printing 
heater and post-heater by roughly 5°C, and print again. 
Assess the reprint to see if there is a patch that can be used.

 If there is still no usable patch after you have raised the heater tempera-
tures, implement a test print once more. Before doing so, increase the 
number of passes on the Image Edit screen. If there is a usable patch, exit 
the Wizard, and start it up again. Then, on the Print Condition page, set the 
number of passes used in the test print.

With some media, the mirror-surface glossiness and/or image quality may still 
be poor even after the print conditions and/or heater temperatures are 
changed. If so, you should change the media you are using.
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5.3 Checking the glossiness and image quality with the silver density         
determined

Set the silver density determined, print the same chart again, and check the silver’s 
glossiness feel.

1 Adjust the silver density to the 
density determined.

2 Press [Test print...].

3 The [Open] dialog box will appear.

Select the following file:
MPMII installation folder ¥Image¥SilverInkLimitTestChart.tif

4 The [Image Edit] screen will be displayed.

Check that “Replace BLACK” is set for the [Silver ink]-[Print method], then press the [Out-
put] button to execute printing.

5 Check the glossiness feel and image quality of the 100% portion of 
the chart printed out.

5.4 Setting the final value

Enter the silver density on the [pecial color information setting] screen, and press 
[Next].

As mentioned earlier, the higher the silver ink’s density, the poorer its abrasive-
ness and wind-up performance are. Accordingly, you are recommended to set 
the silver density as low as possible. 
If, in the chart printed the second time, there is a usable patch with lower density 
than the 100% patches, use the following formula to determine the density value 
to use for MPMII:

Value to use: Value determined from first print × Density of good patch in second 
print

Example : If the density determined from the first print is 70% and the density of the 
patch judged as good in the second chart is 90%: 
70% × 90% = 63%. 
So set 63% for MPMII.

1
2
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6. Whole ink limit

Set the color Whole ink limit.

6.1 Chart print

Print out a chart for checking the density variation of the CMYK single colors.
The chart will be printed in the form of Silver  Color.

1 Return to MPMII, display the [Out-
puts whole ink limit chart] screen, 
and press the [Chart Print...] but-
ton.

2 The [Image Edit] screen will 
appear.

3 Print the chart.

 Leave the silver ink setting at the initial 
value.
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6.2 Assessing the chart printed：Determining the ink limits for the single inks

The chart below will be printed.

Examine the chart visually to find patches that match the following conditions, and 
determine the ink limits for the single colors to be the densities of those patches.
• Patch with density above which density variation is not observed.
• Patch with density above which metallic glossiness is not obtained

Example: With the print results below, the ink limit will be 70%.

1 Press [Next], to go to the [Whole ink limit adjustment] screen.

2 Set for the various colors the ink densities determined.

Gradation almost 
disappeared.

No metallic 
glossiness.

Metallic glossiness felt.
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7. Tertiary ink limit

Set the color ink limit (tertiary color).

7.1 Chart print

Print out a chart for checking the density variation and spillover status of the tertiary col-
ors (CMY). The chart will be printed as Silver  Color.

1 Return to MPMII, display the [Out-
puts tertiary ink limit chart] 
screen, and press the [Chart 
Print...] button.

2 The Image Edit screen will appear.

3 Print the chart.

7.2 Assessing the chart printed out

The chart below will be printed.

Select the patch with the highest density from among the patches that match the follow-
ing conditions:
• Patch that dries within the fixed period.
• Patch whose ink dries evenly.
• Patch whose writing is not blurred.
• Patch that is not in the high-density portion where gradations have disappeared.

 Leave the Silver Ink setting at 
the initial value.



Chapter 10 Create the Metallic Color Profile

10-15

7.3 Test Print

Now run a test print and check the Metallic Color Profile results.

1 Press the [Test print...]

2 The [Open] dialog box will appear.

Select the following two Images:
MPMII installation folder \Image\MetallicColorChart.tif

• This chart uses 294 colors from the “SS21 Metallic Color” color collection supported 
by RasterLink6. It will enable you to check the output if you use the color collection.

MPMII installation folder \Image\MetallicColorInkLimitChart2.tif
• Chart of the CMYK single colors, secondary colors and tertiary colors. Use it to check 

the overall color tones and/or metallic feel.

3 The [Image Edit] screen will 
appear.

Set a color and press [Output].

Check the color tones and glossiness 
feel of the chart printed out.
Besides that, also print out one of your 
own images whose metallic feel you 
want to check.

8. Saving

Save the file.

You can only use a TIFF 
(CMYK) image for this.
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Print checking with RasterLink6

Install to RasterLink6 the Metallic Color Profile you created, and run a final print check.

1. Installing the Metallic Color Profile

Use the Profile Manager to install the Metallic Color Profile, in the same way as with a regular 
device profile.
When you have installed it, “Metallic color” will appear in the [Type] column.

2. Creating a job and applying the profile

Here we give an outline of the operations from creating a job to applying the profile.
For the detailed operations, see the “Metallic Color Pinting Guide” of RasterLink6.

(1) Separating the data for Metallic color and for Color
With RasterLink6, if you want to print an image with Metallic Color and Color mixed 
together, you must separate the image data for Metallic Color from the image data for 
Color. This is because a Metallic Color Profile must be set for the Metallic Color image 
and a regular profile for the Color image.

Example: To print a circle of Metallic Color inside a square:

RasterLink6 provides the following methods for printing Metallic Color.
Color replacement using the “SS21 Metallic Color” collection
Color replacement via manual setting
Creating a silver version via special color generation, and compositing with the color 

to be printed over the silver
Creating a single-color image for the silver, replacing the single color with the silver, 

then compositing with the color to be printed over the silver
Here we give the procedure for manual-operation color replacement of an image 
for Metallic Color.

Final outcome

For Color

Two data sets are needed

For Metallic Color
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(2) Loading the job
Load the image for Metallic and the image for Color 
into RasterLink6.

(3) Making the settings for printing with 
Metallic Color
Select the image job for Metallic Color, and 
open the [Color Replacement] screen.
Select the color that is to be rendered metal-
lic, then specify 100% for Silver, plus the 
color density.

(4) Compositing
Select the job for Color and the job for Metal-
lic Color, then open the [Composition] 
screen. Adjust the jobs' positions so that the 
order become job for Metallic Color  job for 
Color from the bottom to the top, then press 
the [Composite] button to execute composi-
tion.

(5) Making the settings for overprinting
Select the job you have composited, and 
open the [Layer Adjust] screen. Then select 
“Special Color  Color  Color” from the 
[Special Color Over Print].
For [Quality], the value contained in the pro-
file to be set a little later will be set automati-
cally.

 If you have executed color 
replacement, be sure to put a 
check in the “Apply profile ink 
limit” box. If you do not, the 
Metallic Color Profile’s color data 
will not be applied.

Before setting the profile in the print conditions, carry out layer editing.
 If you select the profile in the print conditions without making the [Special 

Color Over Print] settings, it will not be possible to set separate profiles for 
Metallic Color and for Color.

For Color

For Metallic 
Color

Check ordering of jobs before 
pressing
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(6) Setting the profile
Select the composited job, and open the [Quality] screen.

(6)-1 : Setting the image for Metallic Color

(6)-2 : Setting the image for Color

About the print conditions
  the print conditions will vary depending on whether quality for Color or for             

Metallic Color is prioritized. After making the above settings, carry out the set-            
tings for number of passes, print direction and hi-speed.
• If quality for Color is prioritized: 

Select the image for Color, then change the settings for number of passes, print 
direction and hi-speed to the values indicated as “Default”.

• If quality for Metallic Color is prioritized: 
Select the image for Metallic Color, then change the settings for number of 
passes, print direction and hi-speed to the values indicated as “Default”.

About heater temperatures
 If you set “Profile Setting” for [Device Adjustment], the heater temperature val-

ues in the Metallic Color Profile will be used.

1. Select the image for 
Metallic Color

2. Select a Metallic Color Profile that match-
es the media to be used.

3. Select the “Color 
Matching OFF”

4. Concerning the print settings, 
see [NOTE! About the print 
conditions]

5. Select the “Profile Setting”, and 
see [NOTE! About heater tem-
peratures]

1. Select the image for 
Color

2. Select a profile that matches the media to be 
used and has the same resolution as the Metallic 
Color.

3. Concerning the print settings, 
see [NOTE! About the print 
conditions]
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(7) Printing
Print after completing RIP.

If you print using Silver single-color:
 In the case of the following conditions, printing will be executed with settings 

that exclude Special Color Over Print.
a A job that was generated via Single Color Replacement or Special 

Color Version is printed using Silver alone.
b Compositing with Color has been executed, but [Profile Setting] has 

been set for a Silver-only job such as in (a)

In these cases, compared with Special Color Over Print, a large head width 
will be used for printing Silver and it will not be possible to gain time for drying, 
with the result that the image quality will be lower. 
If you want to carry out printing in such cases, set a value higher than the 
default for the number of passes on the print conditions screen after setting 
the Metallic Color Profile.
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Editing/Copying/Resuming a Metallic Color Profile

1. Edit

Like a regular device profile, you can edit a Metallic Color Profile.

1 In the main window, select [Device Profile]–[Edit] to open the Edit 
window.

The Type is "Metallic color" and the Version is "Ver3.3".

2 Open a Metallic Color Profile.

3 Select a Metallic Color Profile and 
press [Edit].

4 Double-click "Edit a Metallic color 
profile" in the list box.

5 Edit the elements of a Metallic 
Color Profile.

6 Like a regular device profile, save the edited profile.

For a Metallic Color Profile, you cannot use the following functions:
Calibration (Base setting/Calibration/Equalization)
Add Information for Replacement

 Test Print
You can perform a Test Print from either of the following pages:
• Special color information setting : Outputs an image in silver monochrome.
• Ink limit : Outputs an image in the following order:  

silver  color.

Double-click
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2. Copy

Copy a created Metallic Color Profile if you want to use it for some other Printer/Resolution, 
etc.

1 In the main window, select [Device profile]–[Copy] to start the Copy 
wizard.

2 When the file selection page is 
displayed, select a Metallic Color 
Profile. 
Press [Next].

3 The creation condition setting page is displayed. 
Select such items as Printer and Resolution and press [Next].

4 The media name selection page is displayed. 
Select a media name and press [Next].

5 The creation condition check page is displayed. 
Check the contents, and if they are OK, press [Next].

6 The Media Character setting page 
is displayed. 
When you are finished setting the 
above, press [Next].

When a Metallic Color Profile is selected, a dialog box appears, indicating that 
the selected file is a Metallic Color Profile.

 Like the example used for describing Metallic Color Profile creation, only the 
silver print conditions we recommend are enabled.

Only a media name for Metallic Color Profile (with "Si" added to the end) can 
be selected.

 The recommended heater temperatures vary depending on the printer. To 
copy data into a different printer, enter the recommended values for that 
printer. 
CJV300 : Pre:50°C/Print:45°C/Post:60°C 
CJV150 : Pre:50°C/Print:45°C/Post:50°C
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7 The Special color information set-
ting page is displayed. 
When you are finished setting the 
above, press [Next].

8 The save page is displayed. 
Save the profile and exit.

3. Creation restart

Like the procedure taken for a regular device profile, you can stop and restart the creation 
process.

 If the Printer/Resolution/Pass data of the original profile is changed, set an 
option other than "Profile setting". 
The preset information in Special color information depends on the Printer/
Resolution/Pass data. However, its default value is "Profile setting" and if it 
is selected, the information in the original profile is used as-is.
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Backup the information of MPM II
Backup function

When reinstalling MPM II, registered media names and interrupt files will be deleted. Backup func-
tion enables to save the data such as registered media names or interrupt files before uninstalling. 
Backup file can be loaded to the reinstalled MPM II by restore function ( P.11-4).

1 Confirm that MPM II is termi-
nated and start "Backup and 
Restoration". 

(1) From the [Start] menu, select [All 
programs].

(2) Select [Mimaki Profile Master II]- 
[MPM tools].

(3) Select [Backup and Restoration].

2 Click .

3 Specify the destination to 
save the backup.

When creating a new 
folder,click [Make New 
Folder]..

Do not specify the folder 
which MPM II is installed.  
If the backup is saved in the 
same folder which MPM II is 
installed, the backup will be 
deleted when MPM II is rein-
stalled.
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4 Click .

Backup starts.

A dialog will appear when backup is 
completed.

5 Click .

The folder named "MPM IIBack-
upYYYYMMDD_hhmmss" is created at 
specified destination.

6 Click .

Close "BackupRestoration Tool".
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Restore the backup file to MPM II
Restore function

"Restoration" function restores the information in the backup data created by backup function 
( P.11-2) to MPM II. This function is used when MPM II is reinstalled.

1 Confirm that MPM II is termi-
nated and start "Backup and 
Restoration". 

(1) From the [Start] menu, select [All 
programs].

(2) Select [Mimaki Profile Master II]- 
[MPM tools].

(3) Select [Backup and Restoration].

2 Click .

3 Specify the backup folder named ("MPMIIBackupYYYYMMD-
D_hhmmss" folder) to restore.
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4 Click .

Restoration is started.

The dialog on the right will appear when 
restoration is completed. 

5 Click .

Restoration is completed.

6 Click .

Close "BackupRestoration Tool".

 If there is no useful information 
for restoration in the specified 
folder, an error massage will 
appear.  
In this case, perform proce-
dures from the Step 2 again.
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Glossary

Term Explanation

Device Profile
The file used for color management. Information of the color space for each            
device such as printer are included in the device profile. It is used to convert              
between the device color and the absolute color space.

Input profile
Target profile

The file made the printer and the designer's output environment to ICC           
profile when matching between the color output from the printer and the           
color sample provided by the designer.

ICC
Abbreviation of International Color Consortium, an organization established       
aiming at creating international standard of color management technology.        
http://www.color.org/

ICC profile

The files used by software such as Photoshop for performing color          
management. In accordance with the format set forth by ICC, color          
conversion information is written in the file. As the data creation policy is            
different depending on the company who developed ICC Profile creation         
application, the results of the output could be different. 

Color Space
In this document, color space means the composite colors the ICC Profile is            
able to output. The ICC profiles that can be handled by MPM is those with              
color space of CMYK. 

Black printer Indicate K ink.

Color Matching
With a view to obtaining good finish at the output device, to convert the data              
of input image in the internal processing of RIP or print driver.

Gamut

Means the color reproduction range.  
Mainly expressed by Lab or X-Y-Z coordinate system. 
Formally, Gamut is a 3-dimentional figure connecting max./min. brightness,        
max./min. saturation, and total color hue that can be reproducible by the           
device. However, for easier comparison, it is often seen with the          
projectedplanes deleting the brightness information.  
The colors looked to be located inside of Gamut on the plane may actually             
be located outside of the Gamut when looked on the 3D figure. Such color             
cannot be reproduced.



Appendix

App.-3

Delta E 
(ΔE, ΔE94, ΔE2000)

Means the difference of the color. The value is shown as "E".  
In general, using Lab space, the distance between two colors within such           
space is called color distance. 
The bigger ΔE may be, the more color difference becomes. 
ΔE94 and ΔE2000 calculate color difference taking into consideration the         
problem of difference between visual evaluation generated from color        
coding range of human eyes' about shape/size and the figure of ΔE. The            
formula is defined so that it may become similar to visual evaluation of            
human eyes'.

Pure color
A color without unnecessary color mixed in its composition. 
For example, the color composed of red only in the case of RGB and M+Y in               
the case of CMYK only is called pure color. 

Hue
Hue is the gradation of color. 
As the colors are arranged cyclic like red, orange, yellow, green, blue, bluish            
purple, reddish purple and red, it is expressed as a circle. (called hue circle)

Brightness

Indicates the brightness of the printed items. 
If the brightness is raised, the image becomes brighter and when maximized           
the color turns to white. On the contrary, if the brightness is decreased, the             
image becomes darker and when minimized the color turns to black. When           
the color is designated only with brightness information, the image becomes          
gray scale.

Saturation

Indicates color saturation. 
When the saturation is increased, the color turns to colorful (vivid) and when            
it is decreased, the color turns to colorless (black and white). Saturation of            
white, gray and black is zero (no saturation).

Density

Indicates deepness of the color. Since the density is brought about with the            
change of brightness and saturation, the density is felt differently depending          
on the colors. For example, red or green is felt deeper when slightly            
darker,but yellow looks deeper when it is brighter. 

Term Explanation

Delta E Application range

～ 0.2
Within the measurement error range. Deemed as same     
color in the color measurement. 

0.3 Accuracy with which recognized as the same color.
0.6 Accuracy of allowable limit as practical difference.

1.2
Accuracy with which recognized as the same color when     
compared side by side.

2.5
Accuracy with which recognized as the same color when     
compared apart.

5.0
Accuracy with which recognized as the same color when     
compared separately.
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Rendering Intent

A color matching method specified in the ICC Profile. 
The ICC Profile specifies the following four: 
The colors to which the colors outside of the Gamut are replaced are            
different depending on each. 
• Perceptual

The color outside of the Gamut is replaced by near color by changing            
the brightness and the saturation without changing the hue. The color          
within the Gamut will be adjusted globally maintaining the gradation. 

• Saturation
The color outside of the Gamut will be replaced by near color by            
changing the brightness maintaining the hue and the saturation as         
much as possible. The replacing color tends to become darker (deeper)          
and the color outside the Gamut could be converted to the same color. 

• Relative Colorimetric
The color outside of the Gamut will be replaced by the nearest color by             
changing the saturation maintaining the hue and the brightness as         
much as possible. The color outside of the Gamut could be converted to            
the same color but the gradation is maintained relatively well. 
Since the colors inside the Gamut reproduce the color truly, this is good            
for proofing application.

• Absolute Colorimetric
The same processing is done as the Relative Colorimetric. However,         
when the white point possessed by input profile is chromatic color          
(news paper or papers with less whiteness), such color is reproduced          
truly. Since the white color on the image is not detained, this is not used              
except for proofing where even the pure color is truly reproduced. 

Gray balance
Gray is theoretically composed of equal value of C, M and Y. In actuality,             
however, the ink contents are different from the ideal hue. Gray balance is            
the adjustment of the ink quantity to reproduce ideal gray.

UCR
Abbreviation of Under Cover Removal. This is a technology considered to          
improve proper printability. To lower the total value of CMYK inks, the gray            
portion of CMY is replaced by K ink. 

GCR

Abbreviation of Gray Component Replacement. This is a technology        
considered to improve plate making. The gray contents composed of C, M           
and Y is entirely replaced by K ink and all colors are expressed by 3 colors               
(K ink plus 2 of CMY inks).

Primary color For four-color ink set (CMYK) ：C/M/Y/K
For six-color ink set (CMYKLcLm) ：C+Lc/M+Lm/Y/K

Secondary color

For four-color ink set (CMYK)：
Red(M+Y)/Green(C+Y)/Blue(C+M)/K+C/K+M/K+Y
For six-color ink set (CMYKLcLm)：
Red(M+Lm+Y)/Green(C+Lc+Y)/Blue(C+Lc+M+Lm)/
K+C+Lc/K+M+Lm/K+Y

Tertiary color
For four-color ink set (CMYK) ：CMY/CMK/CYK/MYK
For six-color ink set (CMYKLcLm)：
C+Lc+M+Lm+Y/C+Lc+M+Lm+K/C+Lc+Y+K/M+Lm+Y+K

Quaternary color For four-color ink set (CMYK) ：CMYK
For six-color ink set (CMYKLcLm) ：C+Lc+M+Lm+Y+K

Term Explanation
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Spot color
Indicates the named color. 
Mainly indicates the color specification with swatch library of Illustrator, and          
marks the color (position) for color replacement on Raster Link series.

Term Explanation
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Note when measuring colors
Depending on the operation for measuring colors, the measured result may be an abnormal value 
in some cases. MPMII adjusts automatically based on the measured value (automatic adjustment 
of linearization, automatic adjustment of gray balance, checking of color difference, adjustment of 
hue, etc.) If there is an abnormality in the measured result, you cannot gain the correct result. 
Especially, abnormality will occur in i1 Pro manually measuring colors. 

Possible phenomena when measured colors result is abnormal

On the MeasureTool5.0 screen, the color of the patch that has already been 
measured depending on the progress of the measuring colors is displayed in 
dark color. 

Be sure to check that this is correct by compar-
ing the color of the patch displayed in dark color 
and the chart actually measured in the middle of 
measurement. (In the right figure, the measured 
colors in the second line are misaligned by 
ones.)

Item Adjustment with an abnormal measuremen

Automatic adjustment of Linearizaion
When you click [Curve adjustment] to display curve, there        
is a billowing color.

Automatic adjustment of Gray balance

Set Basis

When performing calibration adjustment, color difference     
values differ much depending on the color at "Measuring        
colors of current status" that performed first. 
In addition, as each factor of calibration becomes status        
below, calibration cannot be performed properly. 

Hue adjustment
Ink limit value differs much depending on the color.
Especially, when the value below 90% is displayed, check        
the measured colors result.

Confirm delta E
Color difference values differ much depending on the       
color.

 For basic setting, be sure to check there is no abnormality in the measured col-
ors result and then terminate color measuring. If there is an abnormality in the 
measured colors result of the basic setting, calibration adjustment cannot be 
performed properly.
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If you find an abnormality during measuring colors

You can begin to measure colors again in the middle of the operation. 
As an example, procedures of i1 Pro are explained. 

1 Click  on the measuring    
colors screen to return to the 
line with measuring colors 
abnormality.

2 Measure colors in the line with an abnormality again.

When whole line is misaligned
While pressing the i1 Pro button, 
stop for longer time in the non-
printed part on the left end. Then, 
slide it.

When patch color in the middle is 
abnormal

Make the speed to slide i1 Pro 
slower.

3 Repeat the Step 1 and 2 until the measuring colors can be per-
formed properly.

4 Click  to move to the 
next line to measure colors.

Then, continue the measuring colors.
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Check the result of the measuring colors result file

The procedures to check the result of the measuring colors result file when an abnormality has 
occurred in the measured result and it may be abnormal.

1 Move the screen until you can click .

Depending on the current operation, the procedure to display  differs.

When you perform device profile cre-
ating wizard, calibration wizard or 
equalization wizard
Click  or  to display the      
screen with . 

When you edit the device profile
Double-click the item of the calibration 
data. 

 

2 Click .
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3 Click 
.

4 The MeasureTool 5.0 is acti-
vated.

5 Select the measured colors 
result from [File] → [Open].

6 The preview of the measured 
colors result is displayed.

Comparing the measured colors chart 
to the preview, check that there is no 
abnormality in the measured colors. 

If there is an abnormal result, measure 
colors again.
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When a measurement device is used on 
Windows7
On Windows7, installation of the driver may fail when a measurement device is connected to the 
computer. In this case, update the driver. 

(1) First, refer to "Check the driver of the measurement device" to check the driver is properly               
installed. 

(2) If update of the driver is needed, refer to "Update the driver" to update the driver.

Check the dirver of the measurement device

1 Connect the target printer with PC.

2 Select "Start" and then "Control Panel".

3 Open the device manager.

4 Check if the device requires updating.

When " " is displayed next to the 
name of the connected measurement 
device shown as the right, update it.
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Update the driver

1 Select and right-click the measurement device to be updated, and 
then click "Driver-update software" on the shortcut menu.

 

2 Click “Browse my computer for driver software”.

3 Place the installation CD of MimakiProfileMasterII in the CD drive.
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4 Click  and specify 
the following folder.

[CD drive]Driver\EyeOne

5 Click .

The driver software is installed.

6 Click .
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Before using Eye-One iO
If you use Eye-One iO as a measurement device, there may be a case that requires you to update 
the device driver.

(1) Confirm the driver with reference to the “Confirm Eye-One iO driver”
• If driver update is not required, use the driver as it is.

(2) If driver update is required, Uninstall the installed Eye-One iO driver.
(3) Install the new driver.

Confirm Eye-One iO driver

1 Turn on Eye-One iO and connect with PC.

2 Open the device manager.

The following steps open the device manager. (Screen shots are in WindowsXP.)

1 Select [start], do the right click on [My Computer] and Click [Properties] on the             
displayed menu.

 In some case, Eye-One iO can not be used with software besides Mimaki Pro-
file Master after updating the device driver. In this case, confirm to the software 
distributor whether the software supports the Eye-One iO new driver.



App.-14

2 Select [Hardware] tab on [System Properties] and then click  .

3 Confirm whether update is required.
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Way to update the device driver

Uninstalls a device driver which has already been installed.

1 Disconnect Eye-One iO from PC.

 

2 Insert the install CD of Mimaki Profile Master II. Click [Display CD 
contents] when the below window is displayed.

3 Open [FTDI-uninstaller] folder in [EyeOneIO].

Double-click “ i1iO Driver Uninstaller.exe ”.
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4 Uninstaller of Eye-One iO 
starts up.

Click .

5 The right window is displayed, 
click .

6 When  is activated, click 
the button.

Uninstallation is done.

7 Click  to close the 
window.
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Installs a new device driver

1 Turn on Eye-One iO and connect with PC.

[Found New Hardware Wizard] is dis-
played. 
Click .

In WindowsXP SP2, select [No, not this 
time] and click  .

2 Select [Install from a list or specific location.] and  
click .
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3 Select [Search for the best 
driver in these locations.].

4 Select [Include this location in 
the search].

5 Click  and specify 
the following folder.

[CD drive] Driver\ EyeOne

6 Click .

7 Installation is done.

Click  to close the window.
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About handling calibration data when outputting
 When you create the calibration data, measure colors of the chart on which color conver-

sion has been performed only with device profile. 
 When you output with MPMII, use the device profile and the calibration data as below: 

You cannot create new calibration data using the existing calibration data.

Output method Output conceptual diagram

Normal output

Color conversion is 
performed only with device 
profile.

Output by using 
calibration

Gain the calibration data 
form the device profile. 
Correct the device profile 
with the calibration data 
and then convert colors.

Output when 
creating calibration 
data

For calibration function/
equalization function, 
colors are converted only 
with the device profile. 
Measure colors and create 
the calibration data. 
The calibration data is 
saved in the device profile. 

Device Profile

Device Profile

Calibration 
Data 1

Calibration 
Data 1

Gain

Device Profile

Calibration 
Data 1

Calibration 
Data 1

Save

Measure 
colors

Create
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Error Messages

Error Messages and Remedies

How to make remedies when error messages are displayed will be explained below:

Error message
Indicate 

condition
Remedies

No license matches.
At the time of 

activation

• The trial use period has expired.     
Please activate using MPMII   
dongle (SafeNet).

Failed to find a dongle. 
Please plug the dongle into the PC,      
then restart the application. 

At the time of 
activation

• When you activated MPMII using    
dongle, use the dongle to activate     
in the subsequent occasion, too.

Filed to initialize the application.
At the time of 

activation

• A crucial error has occurred in     
MPMII system. Please reinstall the    
MPMII.

There are media names which have     
been registered with another   
dongle. Only the media names for     
the connecting dongle are   
displayed.

At the time of 
activation

• You are using dongle which is     
different from the previous one.    
Although this causes no problem    
to the operation of MPMII, it     
becomes impossible to select the    
media name registered using other    
dongle.

As the connected dongle differs    
from the one at starting, the process      
cannot be continued.

At the time of 
various operations

• Do not remove the black-colored    
dongle while activating MPMII.

The application has stopped   
transactions. Any dongle has not    
been detected. Please plug the    
dongle into the PC, then restart the      
application.

At the time of 
various operations

The file is not supported.

Loading file

• Make sure that you are not     
designating the file other than the     
device profile. 

• You are trying to edit the profile of       
new printer or new ink set. Perform      
version upgrade of MPMII to the     
latest one.

Cannot display a chart to output.
Device Profile 

Creation wizard

• Perform various works after   
selecting the color measuring   
device.
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Filed to create curves. Please make     
sure the chart is set and printed      
correctly. Then do the measurement    
again.

At the time of 
reading color 
measuring file

• A proper curve cannot be    
calculated from the measured   
color values read. Check if the file      
you are using is for measured color      
values of different factors.

• When error message appears   
even though the correct file is     
used, there is possibility of    
mistakes in color measuring.   
Confirm there is no uneven density     
on the printed chart and repeat the      
color measuring once again.

Filed to get valid ink values. At the time of 
reading color 
measuring file

• Check if the file you are using is for        
measured color values of different    
factors.

Failed to load the measurement file     
beacause of an invalid fomat.Please    
choose a measurement file saved    
with a correct format.

At the time of 
reading color 
measuring file

• The color measuring result has    
been saved in spectral reflectance.    
Use the file saved in Lab value.      
(Especially, this may occur when    
you use i1iSis. P.2-44 )

Only CMYK tiff images can be     
outputted during a prolife creation.    
Please select a CMYK tiff file.

Test print
• Until the device profile is    

completed, it is impossible to    
output RGB image.

Selected image size is too small to      
load.
Selected image size is too large to      
load.

Test print

• The image size that can be output      
is over 25.4 mm (1 inch) and less       
than 2500 mm. Change the size     
within this scope.

Filed to import, cannot find valid     
data in the file.

Import

• Make sure that you are not     
designating the file other than the     
device profile. 

• Check if you have designated the     
standard ICC profile instead of V3     
profile in the file with extension of      
".icc".

• Confirm that the ink set of the      
profile currently being edited and    
the ink set of the selected profile      
are same.

• When the profiles with variable    
setting have been made, select the     
profile with variable setting.

The loaded ICC profile does not     
have any CMYK color space.

Import

• When importing ICC profile, you    
have selected profile other than    
CMYK profile. When taking in the     
ICC profile, select the one with     
color space of CMYK. 

Error message
Indicate 

condition
Remedies
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Cannot adjust color. This profile has     
not been created by MPMII. 

Editing the ICC 
profile

• You are using ICC profile prepared     
by MPM1 or other company's ICC     
profile making application. Since it    
is impossible to adjust with MPMII,     
make the adjustment with   
pplication used when that ICC    
profile was made. 

Cannot get media size from printer.     
Please check the connection to a     
printer. Editing image

• Check the cable and make sure     
that the connection with the printer     
is made. 

• ・ Check, on the Windows, if the     
printer is recognized. 

There is the case that is not possible       
adjust by calibration so that delta E      
is too big.

Calibration

• The color difference is not the size      
adjustable with MPMII. Prior to    
performing calibration with MPMII,   
make adjustment of the printer. 

• Confirm if the same printer, same     
ink set, same media, same profile     
as the target for calibration and     
Equalization are used.

Error message
Indicate 

condition
Remedies
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Errors at the time of color measuring and the remedies

Kind of color 
measuring 

device
Phenomenon Remedies

SpectroScan

Initialization operation is not   
completed.

• Confirm that the white reference plate     
is inserted to the upper left part of the        
color measuring surface.

• Confirm that the serial ID written on      
the white reference plate and the     
serial number written on the back of      
SpectroLino (the head part to perform     
the color measuring) are in    
agreement with each other. 

• Pull off the cord for power intake and       
enter the power again after around 5      
minutes. 

The head returns on the way to      
perform the position setting of 3     
markers.

• Continue to press "Online" and    
"Enter" at the same time, and reset      
SpectroScan and repeat the   
operation again. 

Connecting error arises. • When using USB-serial conversion   
adaptor, designate the COM port    
number to be allocated by the     
software attached to the adaptor.    
Select such COM port number with     
MeasureTool5.0.
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i1 Pro

Initialization operation is not   
completed.

• Confirm that the serial ID written on      
the calibration plate and the serial ID      
written on the back of i1 Pro are in        
agreement. 

• Confirm that i1 Pro is firmly placed on       
the calibration plate.

Color measuring error arises. • Color measuring is performed for    
each line. Continue to press i1 Pro      
button while making the color    
measuring. 

• At the beginning of the line (white      
portion on the left) and the end of the        
line (white portion on the right) to be       
measured, wait for around 1 second     
while pressing the button. 

• Move i1 Pro slowly at a constant      
speed. 

• While sliding on the ruler, do not      
make i1 float from the chart. (It is not        
necessary to push it forcibly).

Connecting error arises. • Confirm if the driver is installed     
properly. 

• Change the USB port to insert. (Do      
not use USB hub).

• Remove other USB devices.

The light stays on. • Suspend the color measuring and pull     
off the USB cable. Re-insert the cable      
again after a while.

i1 iO

Color measuring error arises. • Confirm that i1 Pro is firmly inserted      
into the pedestal for i1 iO. Push i1 Pro        
into the pedestal until you feel     
resistance. (It is not necessary to     
push forcibly.)

• When deciding the position of 3     
markers, decide the position at    
slightly outside of the center of the      
batch with frame.

Connecting error arises. • Confirm that two drivers of i1 Pro/i1 iO       
are properly installed. 

• Confirm if i1 iO is firmly assembled. 
• Change the USB port to insert. (Do      

not use USB hub).
• Remove other USB devices.

Kind of color 
measuring 

device
Phenomenon Remedies
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DTP-41

Initialization operation is not   
completed.

• Press the button for a while and when       
LED is lighted in red, press the button       
once more. (Initialized to the state at      
the time of shipment from the plant.) 
Then, press the button for a while and       
when the LED is lighted in orange      
color, press the button once again.     
Have the calibration plate be read to      
perform the calibration of the color     
measuring device.

Color measuring error arises. • Check if the white portions before and      
after the chart are not stained. As      
these portions have to be in white,      
refrain from writing letters etc. there.

• Measure the color while adjusting the     
position so that the chart is fed      
straightly.

The chart stops on the way. • Change the color of the separator     
between the batches close to the line      
where measuring stops of the    
currently measured line.  
When the separator is white colored,     
make it black with magic ink etc.  
When the separator is black colored,     
make it white with correcting pen or      
seal, etc.

• If you pull the chart off forcibly, it will        
be stained. If you pull up the color       
measuring device, you can pull it out      
easily.

Connecting error arises. • When using USB-serial conversion   
adaptor, designate the COM port    
number to be allocated by the     
software attached to the adaptor.    
Select such COM port number with     
MeasureTool5.0.

i1 iSis

Initialization fails. • The white plate may have been     
stained. 
Clean the white plate in accordance     
with the i1 iSis Operation Manual.

Kind of color 
measuring 

device
Phenomenon Remedies
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i1 iSis

Media jams. • Remove the jammed media in    
accordance with the i1 iSis Operation     
Manual.

• If a specific media often jams, the      
media is not suitable for the color      
measuring using i1 iSis.  
Use the other color measuring device.

Color measuring fails. • Did you cut outside the frame line      
widely spaced ?  
When cutting outside the frame line,     
cut the position within 1cm of the      
frame line.

Kind of color 
measuring 

device
Phenomenon Remedies
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